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About This Guide

Revised: September 17, 2012, OL-26822-01

Introduction
This section describes who should read Cisco Service Control Application Reporter User Guide, how it 
is organized, and its document conventions.

This guide is intended for experienced network administrators who are responsible for generating reports 
of the daily operation using the Cisco Service Control Application Reporter (SCA reporter).
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Document Revision History
The Document Revision History table records changes to this document.

Table 1 Document Revision History 

Revision
Cisco Service Control  
Release and Date Change Summary

OL-26822-01 Release 3.8.x 
September 17, 2012

New document for release 3.8.0.
x
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About This Guide
Organization
This guide contains the following sections:

Table 2 Document Organization 

Section Title Description

1 Cisco Service Control Overview Provides a brief overview of the Cisco Service 
Control solution and describes the components of 
the system.

2 Getting Started Provides an introduction to the Cisco Service 
Control Application Reporter (SCA Reporter), 
explains some basic concepts, and provides 
instructions on how to install and launch the SCA 
Reporter. It also provides Basic terminology and a 
QuickStart section.

3 Using the Cisco Service Control 
Application Reporter

Describes basic and advanced configuration of the 
SCA Reporter. It also describes how to navigate in 
the GUI.

4 Managing Report Instances Describes the features of the SCA Reporter, 
including creating a new report instance and 
modifying an existing report instance.

5 Working with Reports Describes the available actions for the SCA 
Reporter, including viewing and adjusting the 
chart display.

6 The SCA Reporter Command-Line 
Interface

Explains how to use the SCA Reporter CLI to 
generate reports.

A Installing and Upgrading SCA 
Reporter Templates

Describes how to install and upgrade SCA 
Reporter templates.

B Troubleshooting Describes SCA Reporter error messages and their 
probable causes and solutions.

C SCA Reporter as a Tool in the SCA 
BB Console

Describes the SCA Reporter as a tool in the SCA 
BB Console.

D SCA Reporter Templates Describes the properties of report instances 
created from the SCA Reporter templates, 
organized by template groups.
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Related Documentation
Use Cisco Service Control Application Reporter User Guide with the following documentation:

 • Cisco Service Control Application for Broadband User Guide

 • Cisco Service Control Application for Broadband Reference Guide

 • Cisco Service Control Application for Broadband Service Configuration API Programmer Guide
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About This Guide
Conventions
This document uses the following conventions:

Note Means reader take note.

Tip Means the following information will help you solve a problem. 

Caution Means reader be careful. In this situation, you might perform an action that could result in equipment 
damage or loss of data.

Timesaver Means the described action saves time. You can save time by performing the action described in 
the paragraph. 

Warning Means reader be warned. In this situation, you might perform an action that could result in 
bodily injury.

Table 3 Conventions 

Convention Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply 
values are in italic font.

[   ] Elements in square brackets are optional.

{x | y | z } Required alternative keywords are grouped in braces and separated by 
vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets and separated by 
vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the string or 
the string will include the quotation marks.

courier font Terminal sessions and information the system displays appear in courier font.

<   > Nonprinting characters such as passwords are in angle brackets.

[   ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code 
indicates a comment line.
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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and 
set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service 
and Cisco currently supports RSS Version 2.0.
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C H A P T E R 1 

Cisco Service Control Overview

Revised: September 17, 2012, OL-26822-01

Introduction
This chapter provides a general overview of the Cisco Service Control solution. This overview 
introduces the Cisco service control concept and its capabilities.

This chapter also briefly describes the hardware capabilities of the service control engine (SCE) platform 
and the specific Cisco applications that together compose the total Cisco service control solution.

 • Cisco Service Control Solution, page 1-2

 • Cisco Service Control Capabilities, page 1-3

 • SCE Platform Description, page 1-4

 • Management and Collection, page 1-6
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Chapter 1 Cisco Service Control Overview
 Cisco Service Control Solution
Cisco Service Control Solution 
Cisco service control solution is delivered through a combination of hardware and specific software 
solutions that address various service control challenges. Service providers can use the SCE platform to 
support classification, analysis, and control of Internet and IP traffic.

Service control enables service providers to:

 • Capitalize on existing infrastructure.

 • Analyze, charge for, and control IP network traffic at multigigabit wire line speeds.

 • Identify and target high-margin content-based services and enable their delivery.

As the downturn in the telecommunications industry has shown, IP Service providers business models 
need to be reworked to make them profitable. Having spent billions of dollars to build ever larger data 
links, providers have incurred massive debts and face rising costs. At the same time, access and 
bandwidth have become commodities where prices continually fall and profits disappear. Service 
providers have realized that they must offer value-added services to derive more revenue from the traffic 
and services running on their networks.

Cisco service control solutions allow the service provider to capture profits from IP Services through 
detailed monitoring, precise, real-time control, and awareness of services as they are delivered.

Service Control for Broadband Service Providers
Service providers of any access technology (DSL, cable, mobile, and so on) targeting residential and 
business consumers must find new ways to get maximum leverage from their existing infrastructure, 
while differentiating their offerings with enhanced IP Services.

Cisco service control application for broadband (SCA BB) adds a layer of service intelligence and 
control to existing networks that can:

 • Report and analyze network traffic at subscriber and aggregate level for capacity planning.

 • Provide customer-intuitive tiered application services and guarantee application service level 
agreements (SLAs).

 • Implement different service levels for different types of customers, content, or applications.

 • Identify network abusers who are violating the acceptable use policy (AUP).

 • Identify and manage peer-to-peer traffic, NNTP (news) traffic, and SPAM abusers.

 • Enforce the AUP.

 • Integrate Service Control solutions easily with existing network elements and business support 
systems (BSS) and operational support systems (OSS).
1-2
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Chapter 1 Cisco Service Control Overview
 Cisco Service Control Capabilities
Cisco Service Control Capabilities
The core of the Cisco service control solution is the network hardware device: the service control engine 
(SCE). The core capabilities of the SCE platform, which support a wide range of applications for 
delivering service control solutions, include:

 • Subscriber and application awareness—Application-level drilling into IP traffic for real-time 
understanding and controlling of usage and content at the granularity of a specific subscriber.

 – Subscriber awareness—Ability to map between IP flows and a specific subscriber to maintain 
the state of each subscriber transmitting traffic through the SCE platform and to enforce the 
appropriate policy on the traffic for this subscriber.

Subscriber awareness is achieved either through dedicated integrations with subscriber 
management repositories, such as a DHCP or a RADIUS server, or through sniffing of RADIUS 
or DHCP traffic.

 – Application awareness—Ability to understand and analyze traffic up to the application protocol 
layer (Layer 7).

For application protocols implemented using bundled flows (such as FTP, which is implemented 
using Control and Data flows), the SCE platform understands the bundling connection between 
the flows and treats them accordingly.

 • Application-layer, stateful, real-time traffic control—Ability to perform advanced control functions, 
including granular bandwidth (BW) metering and shaping, quota management, and redirection, 
using application-layer, stateful, real-time traffic transaction processing. This feature requires 
highly adaptive protocol and application-level intelligence.

 • Programmability—The ability to add new protocols quickly and adapt to new services and 
applications in the service provider environment. Programmability is achieved using the 
Cisco Service Modeling Language (SML).

Programmability allows new services to be deployed quickly and provides an easy upgrade path for 
network, application, or service growth.

 • Robust and flexible back-office integration—Ability to integrate with existing third-party systems 
at the service provider, including provisioning systems, subscriber repositories, billing systems, and 
OSS systems. The SCE provides a set of open and well-documented APIs that allows a quick 
integration process.

 • Scalable high-performance service engines—Ability to perform all of these operations at wire 
speed.
1-3
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 SCE Platform Description
SCE Platform Description
The SCE family of programmable network devices performs application-layer stateful-flow inspection 
of IP traffic, and controls the traffic based on configurable rules. The SCE platform is a network device 
that uses ASIC components and reduced instruction set computer (RISC) processors to exceed beyond 
packet counting and expand into the contents of network traffic. Providing programmable, stateful 
inspection of bidirectional traffic flows, and mapping these flows with user ownership, SCE platforms 
provide real-time classification of network use. The classification provides the basis of the SCE platform 
advanced traffic-control and bandwidth-shaping functionality. Where most bandwidth shaper 
functionality ends, the SCE platform provides further control and shaping options, including:

 • Layer 7 stateful wire-speed packet inspection and classification

 • Robust support for more than 600 protocols and applications, including:

 – General—HTTP, HTTPS, FTP, Telnet, Network News Transfer Protocol (NNTP), Simple Mail 
Transfer Protocol (SMTP), Post Office Protocol 3 (POP3), Internet Message Access Protocol 
(IMAP), Wireless Application Protocol (WAP), and others

 – Peer-to-peer (P2P) file sharing—FastTrack-KazaA, Gnutella, BitTorrent, Winny, Hotline, 
eDonkey, DirectConnect, Piolet, and others

 – P2P VoIP—Skype, Skinny, DingoTel, and others

 – Streaming and Multimedia—Real Time Streaming Protocol (RTSP), Session Initiation Protocol 
(SIP), HTTP streaming, Real Time Protocol (RTP) and Real Time Control Protocol (RTCP), and 
others

 • Programmable system core for flexible reporting and bandwidth control

 • Transparent network and BSS and OSS integration into existing networks

 • Subscriber awareness that relates traffic and usage to specific customers
1-4
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Chapter 1 Cisco Service Control Overview
 SCE Platform Description
Figure 1-1 illustrates a common deployment of an SCE platform in a network.

Figure 1-1 SCE Platform in Network
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Chapter 1 Cisco Service Control Overview
 Management and Collection
Management and Collection
The Cisco service control solution includes a management infrastructure that provides management 
components to manage all aspects of the solution:

 • Network management

 • Subscriber management

 • Service control management

Figure 1-2 shows how these management interfaces comply with common management standards and 
integrate easily with existing OSS infrastructure.

Figure 1-2 Service Control Management Infrastructure
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 • Command-line interface (CLI)—Accessible through the Console port or through a Telnet 
connection, the CLI is used for configuration and security functions.

 • SNMP—Provides fault management (through SNMP traps) and performance-monitoring 
functionality.

LINK RX

Cisco SCE 2000 Series4xGBE

TX

RX MM TX

LINK RX TX

RX MM TX

LINK RX TX

RX MM TX

LINK RX TX

RX MM TX

GBE-1
SUB LINE NET

PWR B STATUS

PWR A
BYPASS

10/100/
1000

LINK/
ACTIVE 10/100/

1000

LINK/
ACTIVE

GBE-2
SUB LINE/CASCADE NET

AUX
CONSOLE

MNG 2
MNG 1

92
76

3

Aggregation
device

SCE platform

RDRs

CLI and SNMP
XML/RPC

Subscriber info

Router

DHCP
or RADIUS

Subscriber
Manager

Provisioning
system

Service
policy and quota

managementNetwork
management

Collection
Manager
1-6
Cisco Service Control Application Reporter User Guide

OL-26822-01



 

Chapter 1 Cisco Service Control Overview
 Subscriber Management—Bridging OSS and SCE Platforms
Subscriber Management—Bridging OSS and SCE Platforms
Where the Cisco service control application for broadband (SCA BB) enforces policies on different 
subscribers and tracks usage on an individual subscriber basis, the Cisco service control management 
suite (SCMS) subscriber manager (SM) may be used as middleware software for bridging between OSS 
and SCE platforms. Subscriber information is stored in the SM database and can be distributed between 
multiple platforms according to actual subscriber placement.

The SM provides subscriber awareness by mapping network IDs to subscriber IDs. It can obtain 
subscriber information using dedicated integration modules that integrate with AAA devices, such as 
RADIUS or DHCP servers.

Subscriber information may be obtained in one of two ways:

 • Push mode—SM pushes subscriber information to the SCE platform automatically upon login of a 
subscriber.

 • Pull mode—SM sends subscriber information to the SCE platform in response to a query from the 
SCE platform.

Managing Service Configuration
Service configuration management is the ability to configure the general service definitions of a service 
control application. A service configuration file containing settings for traffic classification, accounting 
and reporting, and control is created and applied to an SCE platform. The SCA BB application provides 
tools to automate the distribution of these configuration files to SCE platforms. This standards-based 
approach makes it easy to manage multiple devices in a large network.

Service control provides a GUI to edit and create these files and a complete set of APIs to automate their 
creation.

Performing Data Collection
Data collection occurs as follows:

1. All analysis and data processing functions of the SCE platform result in the generation of Raw Data 
Records (RDRs), which the SCE platform forwards using a simple TCP-based protocol 
(RDR-Protocol).

2. The Cisco service control management suite collection manager processes the RDRs.

3. Collection manager software is an implementation of a collection system that receives RDRs from 
one or more SCE platforms. It collects these records and processes them in one of its adapters. Each 
adapter performs a specific action on the RDR.

RDRs contain various information and statistics, depending on the configuration of the system. Three 
main categories of RDRs include:

 • Transaction RDRs—Records generated for each transaction, where a transaction is a single event 
detected in network traffic. The identification of a transaction depends on the particular application 
and protocol.

 • Subscriber Usage RDRs—Records generated per subscriber, describing the traffic generated by that 
subscriber for a defined interval.

 • Link RDRs—Records generated per link, describing the traffic carried on the link for a defined 
interval.
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C H A P T E R 2

Getting Started

Revised: September 17, 2012, OL-26822-01

Introduction
The Cisco Service Control Application Reporter (SCA Reporter) is the Cisco Service Control 
Application tool that allows you to produce reports based on the traffic analysis performed by the Service 
Control Engine (SCE) platform. The information is sent from the SCE platform and is stored in a 
database. The SCA Reporter can query and retrieve information from the database and present the results 
in a comprehensive range of reports, including global monitoring, subscriber monitoring, P2P, and traffic 
discovery statistics reports.

 • System Components, page 2-2

 • System Requirements, page 2-3

 • Installing the SCA Reporter in Windows, page 2-4

 • Installing the SCA Reporter in Linux, page 2-5

 • Starting the SCA Reporter, page 2-6

 • Configuring the SCA Reporter, page 2-7

 • Using Online Help, page 2-22

 • QuickStart—Getting Started with the SCA Reporter, page 2-25
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 System Components
System Components
The SCA Reporter is a valuable tool for understanding the habits and resource consumption of the 
applications and subscribers that use your network. It can also be used to judge the efficacy of various 
rules and the possible impact of their implementation on the network.

The SCA Reporter is available only in a deployment with a database. You can generate reports using any 
of the following methods:

 • Standalone application

 • Command-line interface (CLI)—See The SCA Reporter Command-Line Interface, page 6-1

 • Tool of the SCA BB Console—See SCA Reporter as a Tool in the SCA BB Console, page C-1

The available reports can be displayed in various chart renderings (for example, stacked-bar or area) or 
in tabular form. You can adjust the chart display for various presentation options (for example, 3D). You 
can export both tabular and chart reports to multiple file formats as well as print or send the reports 
through e-mail. You can also modify the reports by changing the values assigned to the properties (for 
example, time boundaries). You can duplicate, save, and add reports to Favorites.

You can also generate reports using the SCA Reporter command-line interface (CLI) without using the 
GUI.

SCA Reporter consists of visual components (known as views). The following are the views and the tasks 
that you can perform in each view:

 • Templates view—Select a report template, create a new report instance, and generate a report.

 • Properties view—View properties of the object in focus and their values. The object in focus can be 
a template group, a report template, a report instance, or the chart display of a report. You can 
configure report instance and chart display properties.

 • Report view—View a graphical representation or tabular display of the data of the report. Each 
report is displayed in its own report view.

 • Progress view—Monitor reports executed or exported. You can view progress details in this view, 
and also choose to generate reports in the background so that you can continue working on other 
reports.

 • Favorites view—View a list of frequently used report templates and generate a report.

 • Hierarchy view—View the report metrics in a hierarchical tree. You can select and deselect metrics 
to add and remove them from the report.

Generating a report can be divided into five broad steps:

1. Create a report instance from the Templates view using the New Report wizard.

a. Configure the properties of the report instance.

b. Execute the new report instance (optional).

c. Add the new report instance to the favorites view (optional).

2. View the report in tabular or graphic form in its report view.

3. Select and deselect chart items in the hierarchy view to view a subset of the report data.

4. Expand and collapse chart items in the hierarchy view.

5. Adjust the chart display of the report in the Properties view.

You can generate multiple reports simultaneously and later export, print or send the reports through 
e-mail. While the reports are executing, you can monitor them and put them in the background by using 
the Progress view.
2-2
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System Requirements
You can install and run the SCA Reporter GUI front end and command-line application on any computer 
running Windows 2000, Windows XP or Windows 7.

You can install the SCA Reporter command-line application for Linux on any computer running Red Hat 
Enterprise Linux 4 or 5.

The computer should have a minimum of 512 MB of memory; 1024 MB of memory is highly 
recommended.

Minimum screen resolution is 1024 by 768 pixels.
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Installing the SCA Reporter in Windows
 • Installing the SCA Reporter in Windows, page 2-4

 • Uninstalling the SCA Reporter in Windows, page 2-4

Installing the SCA Reporter in Windows

Step 1 Navigate to the SCA Reporter installation file, SCA Reporter 3.8.0 Setup.exe, and double-click it.

The Welcome to the SCA Reporter 3.8.0 Setup wizard window appears.

Step 2 Click Next. The Choose Install Location window of the SCA Reporter 3.8.0 Setup wizard appears.

Step 3 (Optional) To install it on a different directory, click Browse.

Step 4 Click Next. The Choose Start Menu Folder window of the SCA Reporter 3.8.0 Setup wizard appears.

Step 5 (Optional) To install it on a different location, enter a different Start Menu folder in the Start Menu 
Folder field.

Step 6 Click Install. The Installing window of the SCA Reporter 3.8.0 Setup wizard appears.

Step 7 Wait until installation is complete. The Completing the SCA Reporter 3.8.0 Setup wizard window 
appears.

Step 8 Click Finish. The SCA Reporter 3.8.0 Setup wizard closes. The SCA Reporter is now installed on the 
machine.

Uninstalling the SCA Reporter in Windows

Step 1 Choose Start > All Programs > Cisco SCA > SCA Reporter 3.8.0 > Uninstall. The Welcome to the 
SCA Reporter 3.8.0 Uninstall wizard appears.

Step 2 Click Next. The Uninstall SCA Reporter 3.8.0 window appears.

Step 3 Click Uninstall. The Uninstalling window appears.

Step 4 Wait until uninstallation is complete. The Completing the SCA Reporter 3.8.0 Uninstall wizard window 
appears.

Step 5 Click Finish. The SCA Reporter is uninstalled from the machine.
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Installing the SCA Reporter in Linux
You can install the SCA Reporter in Linux, and then run it from the command line (see The SCA 
Reporter Command-Line Interface, page 6-1).

 • Installing the SCA Reporter in Linux, page 2-5

 • Uninstalling the SCA Reporter in Linux, page 2-5

Installing the SCA Reporter in Linux

Step 1 Download the SCA BB installation package (reporter-cmd-linux.tgz) from the CCO.

Step 2 Open the installation package in a selected directory, using the tar xpzf reporter-cmd-linux-3.8.0.tgz 
command.

Step 3 Run the reportercmd.sh –setup command from the installation directory.

Uninstalling the SCA Reporter in Linux
Delete the installation directory.
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Starting the SCA Reporter
Access the SCA Reporter from the Start menu.

Step 1 Choose Start > All Programs > Cisco SCA > SCA Reporter 3.8.0 > SCA Reporter 3.8.0.

The Cisco Service Control SCA Reporter splash window appears. After the SCA Reporter loads, the 
main window of the SCA Reporter appears, displaying the Welcome view.

Step 2 Close the Welcome pane. The Templates pane appears, see Figure 2-1.

Figure 2-1 Templates
T
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Configuring the SCA Reporter
To configure the SCA reporter, create a basic configuration for the SCA reporter. This procedure 
includes selecting a database type, connecting to a database, activating the database, and setting the IP 
address of the Service Control Engine (SCE) platform whose service configuration data is to be used.

In bundled mode, the Cisco Service Control Management Suite (SCMS) Collection Manager (CM) is 
used with the Sybase Adaptive Server Enterprise (Sybase ASE). The Sybase data management platform 
supports transaction-intensive enterprise applications. It enables you to store and retrieve information 
online and can warehouse information as needed. (For more information, see Cisco Service Control 
Management Suite Collection Manager User Guide.) The CM can also be configured to work with 
Oracle and MySQL databases.

After a database is activated, select the IP address of one of the SCE platforms in tThe database. The 
choice is made for each repository, represented by a tab in the Preferences (Filtered) window. The service 
configuration applied to the configured SCE platform determines all options offered in the Templates 
view of the SCA Reporter (available packages, services). Each report is generated according to the SCE 
device to which it is configured. In the example configuration, there is one SCE device connected to the 
database and one repository preference.

 • Managing Database Connections, page 2-7

 • Setting the IP Address of an SCE Platform, page 2-11

 • Setting Chart Colors, page 2-13

 • Configuring the Legend in Charts, page 2-19

 • Configuring Advanced Options for the SCA Reporter, page 2-21

Managing Database Connections
To use the SCA Reporter, you must create and activate a connection to a database containing data 
generated from an SCE platform.

You can add connections to a number of databases, and then change the active database as required.

 • Adding a Database Connection, page 2-8

 • Activating Database Connections, page 2-11
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Adding a Database Connection

A database connection can be added using the Add Database wizard.

Step 1 At the Main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears, see Figure 2-2.

Step 2 From the Reporter tree, choose Reporter > Databases.

Figure 2-2 Preferences (Filtered) (Databases)

Step 3 In the Databases pane, click Add. The Add Database wizard window appears, see Figure 2-3.

Figure 2-3 Add Database Wizard
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Step 4 Select one of the Choose definition mode radio buttons.

 • Simple

 • Advanced

Step 5 Click Next.

The Define new database connection window appears. The display depends upon the definition mode 
selected in Step 4:

 • If you selected Simple definition mode, the display of the Define new database connection window 
is as shown in Figure 2-4

Figure 2-4 Define New Database Connection
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 • If you selected Advanced definition mode, the display of the Define new database connection 
window is as shown in Figure 2-5

Figure 2-5 Advanced Definition

Step 6 Enter the required details to fill in all fields.

Step 7 (Optional) Check the Activate this database check box.

Step 8 Click Finish. The Add Database wizard closes.

The definition of the database is added to the list in the Preferences (Filtered) window, see Figure 2-6.

Figure 2-6 Preferences (Filtered)—Databases
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Step 9 Click Test Active DB.

The database connection is tested.

 • If successful, the following message appears: Click OK.

 • If unsuccessful, reconfigure the database connection.

Step 10 Click OK. The Preferences (Filtered) window closes.

Activating Database Connections

Step 1 At the main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears.

Step 2 From the Reporter tree, choose Reporter > Databases. All defined database connections are listed in 
the table.

A check mark ( ) indiates the currently active database (if any).

Step 3 Choose the database connection you wish to activate.

Step 4 Click Activate.

Step 5 Click OK. The database is activated.

The first IP address listed for policy data is selected as the IP address of the SCE platform whose service 
configuration data is to be used in reports. The Preferences (Filtered) window closes.

Setting the IP Address of an SCE Platform
The IP address is set automatically to the first entry of the IP list, when the database is activated. To 
change the IP address, use this procedure.

Note The Preferences (Filtered) window contains one tab for each repository (set of templates) available in 
the Reporter. In each template, you choose one SCE platform. If there is more than one repository, more 
than one set of template groups in the Templates view exists.
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Step 1 At the main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears, see Figure 2-7.

Step 2 In the Reporter tree, select Reporter > Templates.

Figure 2-7 Preferences (Filtered)—Templates

Step 3 In the Templates pane, from the IP of SCE for policy data drop-down list, choose the IP address of the 
SCE platform whose service configuration data is to be used in reports. This IP address is added to the 
SCA Reporter templates repository.

Step 4 Click Apply. The IP address of the SCE platform is set for service configuration data.

Note Before you close the dialog box, you must click Apply.

Step 5 Click OK. The Preferences (Filtered) window closes.
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Setting Chart Colors
Instead of using the default color set for charts that is installed as part of the Reporter installation (the 
predefined colors are packaged within the SCA BB Templates package), you can define your own color 
sets.

This feature allows you to ensure color persistence between different sessions of the Reporter, including:

 • Different sessions of the same Reporter installation

 • Different Reporter installations using data from the same SCE platform, by exporting and importing 
color files

 • Different Reporters using data from different SCE platforms

 • Different versions of the Reporter

For information on Color Sets and changing legend item color, see Using Color Sets, page 2-14 and 
Changing a Single Legend Item Color, page 2-16.
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Using Color Sets

Each line of a color set file defines the color of one legend item. It is recommended that you avoid editing 
the color set file manually.

Step 1 At the Main menu, choose Preferences (Filtered)> Reporter. The Preferences (Filtered) dialog box 
appears.

Step 2 In the Reporter tree, choose Reporter > Charts Colors. The Charts Colors pane appears, see Figure 2-8.

Figure 2-8 Chart Colors Preference

Step 3 Select an action to perform:

 • To import a color set from a file, click Import.

An Open dialog box appears. Browse to the required file and click Open. The file is imported and 
overwrites the existing color set.

 • To export the current color set to a file, click Export.

A Save As dialog box appears. Browse to the required directory, enter a file name in the File name 
field, and click Save. The color set is exported.

 • To Restore the default color set (the predefined colors delivered with the SCA BB Templates 
package), click Restore Defaults.
2-14
Cisco Service Control Application Reporter User Guide

OL-26822-01



 

Chapter 2 Getting Started
 Setting Chart Colors
 • To enable the color allocation method used before release 3.5.0, check the Enable legacy coloring 
mode check box, see Figure 2-9.

Figure 2-9 Chart Colors - Enable Legacy Coloring Mode

Note Before applying Import, Restore Defaults, or Enable legacy color mode, a Confirm discarding color 
settings dialog box appears, see Figure 2-10.

Figure 2-10 Confirm Discarding Color Settings

Step 4 Click OK. The Preferences (Filtered) window closes.
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Changing a Single Legend Item Color

Step 1 At the Main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears.

Step 2 In the Reporter tree, choose Reporter > Charts Colors. The Charts Colors preference pane appears.

Step 3 Select a legend item (in the following window, a service) from the color tree.

The current color of the legend item appears in the upper right corner of the Charts Colors pane, see 
Figure 2-11.

Figure 2-11 Current Color

Note Possible categories of legend items are Direction, Hostname, Host IP, Protocol, MOS, Range, Codec, 
Port Number, Newsgroup, Protocol, Service, Measure, and Subscriber. 
 
Categories and legend items are only displayed in the Charts Colors pane after colors are allocated to 
legend items. Colors are allocated to any legend items in the chart the first time a report instance is 
executed.
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Step 4 Click the color. A color palette window appears, see Figure 2-12.

Figure 2-12 Color Palette
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Step 5 Select a new color for the legend item and click OK.

The Color window closes. The selected color is applied to the legend item, see Figure 2-13.

The Reset button is enabled.

Figure 2-13 Selected Color Applied

Note The Reset button restores the default color of a single selected legend item.
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Configuring the Legend in Charts
You can globally configure the appearance of the legend in charts.

Step 1 At the Main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears, see Figure 2-14.

Step 2 In the Reporter tree, select Reporter > Configuration.

Figure 2-14 Preferences (Filtered)—Configuration

Step 3 (Optional) Uncheck the Show item check box in legend check box.

Step 4 (Optional) Uncheck the Allow multi column in legend check box.

Step 5 (Optional) In the Max legend percentage field, enter a new value.

Step 6 Click OK. The new settings are saved. The Preferences (Filtered) window closes.
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Configuring Hierarchy View
To configure several attributes of the Hierarchy view:

Step 1 At the Main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears, see Figure 2-15.

Step 2 In the Reporter tree, select Reporter > Configuration.

Figure 2-15 Preferences (Filtered)—Configuration

Step 3 (Optional) Check open hierarchy view on start.

Step 4 (Optional) In the services tree default level field, enter a new value.

Step 5 (Optional) In the sorted tree number of services on other group field, enter a new value indicating the 
number of services to include in the Other group of the hierarchy.

Step 6 Click OK. The new settings are saved.

The Preferences (Filtered) window closes.
2-20
Cisco Service Control Application Reporter User Guide

OL-26822-01



 

Chapter 2 Getting Started
 Configuring Advanced Options for the SCA Reporter
Configuring Advanced Options for the SCA Reporter
You can configure the following advanced options of the SCA reporter:

 • Logging debug messages

 • Length of time to wait for a database connection

 • Maximum number of report instances that can be executed simultaneously

Step 1 At the Main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears, see Figure 2-16.

Step 2 In the Reporter tree, choose Reporter > Configuration.

Figure 2-16 Preferences (Filtered)—Configuration

Step 3 To log debug messages, check the Send debug messages to log check box.

Logging debug messages can cause the log file to grow rapidly.

Step 4 Enter a new value in the seconds to wait for a database connection field.

Step 5 Enter a new value in the maximum number of reports that can be executed simultaneously field.

Step 6 Click OK. The new settings are saved. The Preferences (Filtered) window closes.
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Using Online Help
 • Accessing Online Help, page 2-22

 • Using Online Help Search, page 2-23

Accessing Online Help
To access parts of this user guide from the SCA reporter:

Step 1 From the Help menu, choose Help Contents. Online help appears in a separate window. For more 
information, see “Using Online Help Search” section on page 2-23.
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Using Online Help Search
You can also search online help from inside the SCA Reporter.

Step 1 From the Help menu, choose Search. The Help view appears in the Reporter window (Figure 2-17).

Figure 2-17 Reporter Help

Step 2 Enter a word, phrase, or expression in the Search expression field.

The Go button is enabled.

Note Click >> (Expand) for an explanation of how to construct search expressions.

Step 3 Click Go. Help topics containing your search expression appear under Local Help.

Step 4 To view its contents, click a help topic.

Note You can bookmark topics for later reference.
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Step 5 By clicking the appropriate link at the bottom of the Help view, you can switch to:

 • All topics

 • Related topics

 • Bookmarks
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QuickStart—Getting Started with the SCA Reporter
This QuickStart section helps you get started with the SCA Reporter. You can configure the Reporter, 
create a report instance and generate a report, and then work with the report.

 • Creating a First Report, page 2-25

 • Working with a First Report, page 2-31

Creating a First Report

Step 1 Launch the SCA Reporter (choose Start > All Programs > Cisco SCA > SCA Reporter 3.8.0 > 
SCA Reporter 3.8.0) (Figure 2-18).

Figure 2-18 Reporter

Step 2 Add, configure, and activate a database connection (see Managing Database Connections, page 2-7).

Step 3 Confirm that there is an active database and that the system is configured correctly. 

a. At the Main menu, choose Preferences (Filtered) > Reporter. The Preferences (Filtered) window 
appears.

b. In the Reporter tree, choose Reporter > Databases.

c. In the Databases pane, click Test Active DB.
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Step 4 In the Templates view, expand the node of one of the template groups, see Figure 2-19.

Figure 2-19 Templates
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Step 5 Do one of the following:

 • Double-click a report template

 • Right-click a report template.

A report template popup menu appears, see Figure 2-20.

Figure 2-20 Templates Popup Menu
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Step 6 From the menu, select New. The New Report wizard appears, see Figure 2-21.

Figure 2-21 New Report Wizard

The report instance has the same name as the report template with the addition of “#1”. You can 
optionally rename the report instance by entering a name in the Report name field.

Step 7 Configure the report instance properties

If any property has the value  (not set), you must assign a value to it.
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Step 8 Click Next (Figure 2-22).

Figure 2-22 Select Report Actions

Step 9 Click Finish.

A report instance is added below the report template, see Figure 2-23.

Figure 2-23 Report Instance Added
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The report instance appears in the Favorites view, see Figure 2-24.

Figure 2-24 Favorites

A report view, with the name of the report instance, appears in the top right of the SCA Reporter window, 
displaying a chart of the report, see Figure 2-25.

Figure 2-25 Report
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All the services included in the report are included in the Hierarchy view, see Figure 2-26.

Figure 2-26 Hierarchy

Step 10 View your report. The chart display properties are shown in the Properties view, see Figure 2-27.

Figure 2-27 Properties

Working with a First Report

Step 1 Create a report, as described in the previous procedure.

Step 2 Adjust the chart display by modifying the chart display properties in the Properties view. (See Adjusting 
the Chart Display, page 5-14.)
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Step 3 In the Hierarchy view, uncheck several chart items. The modified report appears in the report view, see 
Figure 2-28.

Step 4 In the report view, from the drop-down menu above the view, choose Go To Report.

Figure 2-28 Modified Report

The Properties view displays the report instance properties.

Step 5 Display all the report instance properties by clicking  (Show Advanced Properties) (Figure 2-29).

Figure 2-29 Report Properties

Step 6 Modify one or more properties. (See Modifying Existing Report Instances, page 4-8.)
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Step 7 Click  (Execute) to regenerate the report.

The modified report is displayed in the report view, see Figure 2-30.

Figure 2-30 Modified Report

(In the illustrated example (Figure 2-30), the Traffic Direction and Units of results properties were 
modified).
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Using the Cisco Service Control Application 
Reporter

Revised: September 17, 2012, OL-26822-01

Introduction
This chapter explains how to use the Cisco Service Control Application Reporter (SCA Reporter) GUI, 
which includes navigating and configuring tasks.
3-1
o Service Control Application Reporter User Guide



 

Chapter 3 Using the Cisco Service Control Application Reporter
 Using Views to Navigate the Reporter
Using Views to Navigate the Reporter
You can navigate to template groups, report templates, and report instances in the Templates view. When 
you select an item in the Templates view, the Properties view shows its properties.

You can add the report instances that are used frequently to favorites and view them in the Favorites view

When you generate a report, a report view opens. The Hierarchy view displays a hierarchy of all the chart 
items included in the report and the Properties view shows the chart display properties of the report. To 
view the report instance properties, select the report instance in the Templates view. If necessary, you 
can locate the report instance that generated the report by choosing the drop-down menu item Go to 
report.

Each report view is named after the report instance that generated the view. For example, a report may 
be named Global Bandwidth per Service #1. You can rename the report instance in the Templates or 
Favorites view.

By default, each report view shows the chart of the report. You can view the raw data by clicking the 
Table tab.

 • Viewing Menu Items, page 3-2

 • Configuring Properties, page 3-2

 • Properties View, page 3-4

Viewing Menu Items
The GUI has a drop-down menu for each view, which displays all available actions for that view. Some 
commonly used actions have icons for easy navigation.

The GUI also has a popup menu for each view. Right-click the tab of a view, and select an option to 
personalize the layout of the SCA Reporter window. Some of the available actions are:

 • Detached—Detach a view and move it over the SCA Reporter window.

 • Move—Move a view or a tab group.

 • Size—Change the size of a pane.

Configuring Properties
Before generating a report, you can modify the values of the report instance properties. The new values 
are saved and applied the next time the report is generated.

You can also modify the values of chart display properties. For chart display properties, the value is 
applied at once.
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 Configuring Properties
Types of properties include:

 • No Value—When no value is assigned, (not set) is displayed. Mandatory properties that have no 
default value display as  (not set).

 • Free Text—You can enter any text string.

 • Boolean—The value toggles between True and False.

 • Date—Click the  icon to open a Choose Date and Time dialog box.

 • Single Choice—Click the  icon to open a drop-down menu.

Note If there are less than five items in the list, a drop-down menu appears. If there are five or 
more items, a list box appears.

 • Multiple Choice—Click the  icon to open a dialog box where more than one value can be 
checked.

The icons of the Multiple Choice dialog box are described in Table 3-1.

Note Some properties are mutually exclusive. The properties From the last number of hours and Starting 
after date and time cannot both be implemented, even if both are selected. 
 
Therefore, if you want to define the time frame to begin at a specified time, select Starting after date. 
Even if From the last number of hours is also chosen, the report time frame will be according to the 
date and time values.

Table 3-1 Multiple Choice Dialog Box Options 

Icon Option Description

Select All Select all values.

Invert Selection Uncheck the checked boxes and check the 
unchecked.

Select None Uncheck all boxes.

Search Search the selected items.

Cancel Exit the Multiple Choice dialog box without 
saving.

OK Save and exit the Multiple Choice dialog box.
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Properties View
The Properties view always shows the properties of the item that is selected in the view in focus. You 
can control how the properties are displayed by clicking on one of the following buttons:

 •  (Show Categories)—To view the properties with or without their categories.

 •  (Show Advanced Properties)—To view all properties or only basic properties.

 •  (Restore Default Value)—To reset a selected property to its default value:

 – When a property is optional, it is unset.

 – When a property is mandatory and has a default value, it is reset to the default value.

 – When a property is mandatory and does not have a default value, the value is not changed.

To change the value of a property, select the property and reconfigure it. For details, see Configuring 
Report Instance Properties, page 4-9 and Configuring the Properties of a Chart Display, page 5-14. 

Run the report instance again so that the new report appears with the new configuration.

How to Change the Display of Properties in the Properties View

Step 1 In the Templates view, select a report template and create a report instance.

The Properties view displays the report instance properties. see Figure 3-1.

Figure 3-1 Properties (Report Instance)

By default, the property categories are displayed and advanced properties do not appear.

Step 2 Click  (Show Categories).

The display of property categories is toggled off, see Figure 3-2.

Figure 3-2 Properties Toggled Off
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Step 3 Click  (Show Advanced Properties). All properties appear, see Figure 3-3.

Figure 3-3 Properties Toggled On

Step 4 Click  (Show Categories). The display of property categories toggles on, see Figure 3-4.

Figure 3-4 Display Properties Toggled On
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Managing Report Instances

Revised: September 17, 2012, OL-26822-01

Introduction
The Cisco Service Control Application Reporter (SCA Reporter) installation includes report templates 
for a wide variety of reports, such as:

 • Global, per package, or per subscriber hourly or daily usage volume per service

 • Top server/clients/protocols/web hosts/e-mail senders/newsgroups

 • Top P2P consumers/uploaders/downloaders/protocols

 • Global, package, or subscriber bandwidth per service

Each report instance is based on a report template. You can create, select, duplicate, and delete 
report instances in the Templates view of the SCA Reporter. You can add frequently used reports to 
the Favorites view. When you select a report instance, its properties are displayed in the Properties 
view; you can specify values for the various report properties. For example, if you want to see global 
bandwidth per service, you can create a new report instance from the Templates view. The Properties 
view allows you to specify the desired services, traffic direction, and time frame (either start/end 
time or previous number of hours).

The exact procedure for defining a report instance depends on the report template selected. The 
example in this chapter is intended as a general guide to the process of creating and defining a new 
report instance.

 • Creating a New Report Instance, page 4-2

 • Modifying Existing Report Instances, page 4-8

 • Configuring Report Instance Properties, page 4-9

 • Duplicating an Existing Report Instance, page 4-11

 • Renaming an Existing Report Instance, page 4-11

 • Deleting a Report Instance, page 4-12

 • Removing a Report Instance from Favorites, page 4-12

 • Modifying a Report Chart Title, page 4-13
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Creating a New Report Instance

Step 1 Do one of the following:

 • In the Templates view, right-click a report template (for example, Global Monitoring > Global 
Bandwidth per Service versus Total Bandwidth).

 • In the Templates view, double-click a report template. A popup menu appears, see Figure 4-1.

Figure 4-1 Templates Popup Menu
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Step 2 From the menu, choose New.

The New Report wizard window appears, see Figure 4-2.

Figure 4-2 New Report Wizard

A report instance is added below the report template, see Figure 4-3.

Figure 4-3 Report Instance

The report instance is named Global Bandwidth per Service versus Total Bandwidth #1. (If you create 
another report instance from this report template, it will be named Global Bandwidth per Service vs Total 
Bandwidth #2, and so on. You can optionally rename report instances by entering a name in the Report 
name field.)
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Step 3 Configure the report instance properties.

If any property has the value (not set), you must assign a value, see Figure 4-4.

Step 4 Click Next.

Figure 4-4 Report Instance Properties
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Step 5 (Optional) Uncheck Execute the new report, see Figure 4-5. 

Step 6 (Optional) Uncheck Add the new report to Favorites, see Figure 4-5.

Figure 4-5 Report Actions
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Step 7 Click Finish.

A report instance is added below the report template.

The Properties view appears in the bottom right of the SCA Reporter window, displaying the basic and 
advanced report instance properties, see Figure 4-6.

Figure 4-6 Properties (Report Instance)

You can display all report instance properties by clicking  (Show Advanced Properties).
4-6
Cisco Service Control Application Reporter User Guide

OL-26822-01



 

Chapter 4 Managing Report Instances
 Using the Reports View Toolbar
Using the Reports View Toolbar
After a report is created, you can perform several actions on the active report using the Reports view 
toolbar.

For a description of the available actions, see the “Report Actions” section on page 5-2.

Adding a Report Instance to Favorites
If you have a report instance that you generate frequently, you can add it to the Favorites view. From 
Favorites view, you can quickly access, rename, and delete the instance as well as generate reports.

Step 1 In the Templates view, right-click a report instance.

A popup menu appears, see Figure 4-7.

Figure 4-7 Templates Popup Menu

Step 2 From the menu, select Add to Favorites. The report instance is added to the Favorites View, see 
Figure 4-8.

Figure 4-8 Favorites
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Modifying Existing Report Instances

Step 1 Select a report instance. Do one of the following:

 • Select an existing report view and, from the drop-down menu above the view, choose Go to report.

 • Select a report instance from the Templates view.

 • Select a report instance from the Favorites view.

The Properties view window displays the report instance properties.

Step 2 Edit a property. To edit the property, click on the row of the property and make changes.

The change is saved. The new value is used the next time the report instance is executed.
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Configuring Report Instance Properties
The following is an example of assigning values to report instance properties.

Step 1 In the Templates view or Favorites view, choose (or create) a report instance.

The report instance is selected in the Templates view, and the Properties view displays the report instance 
properties.

Note If the property that you wish to modify does not appear, click  (Show Advanced 
Properties).

Step 2 Click in the Traffic Direction property row and then click the icon that appears.

A drop-down menu of property values appears, see Figure 4-9.

Figure 4-9 Property Values Drop-Down Menu

If fewer than five items appear in the list, a drop-down menu appears. If five or more items exist, a list 
box appears.

Step 3 Select a value.

Step 4 Click in the Services to View property row and then click the icon that appears.

A checklist of property values appears, see Figure 4-10.

Figure 4-10 Property Values Checklist

Step 5 Check the services you want to view.

Step 6 Click  (OK).
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Step 7 Click in the Ending Before Date property row and then click the icon that appears.

A choose date and time dialog box appears, see Figure 4-11.

Figure 4-11 Choose Date and Time

Step 8 Select a date and time and click OK.

Step 9 Click  (Execute).

The report is generated with the configured values.
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Duplicating an Existing Report Instance
Duplicating an existing report instance is a useful way to create a new report instance similar to an 
existing report instance. It is faster to duplicate a report instance and then modify the duplicate, rather 
than to define the new report instance.

Step 1 In the Templates view, right-click a report instance. A popup menu appears, see Figure 4-12.

Figure 4-12 Templates Popup Menu

Step 2 From the menu, choose Duplicate.

The report instance is duplicated.

Renaming an Existing Report Instance
You can rename an existing report instance. This feature is useful when the same report is generated on 
a regular basis. You can include the date or other identifying information in the name of the report.

Step 1 In the Templates view or Favorites view, right-click a report instance. A popup menu appears, see 
Figure 4-13.

Figure 4-13 Templates Popup Menu

Step 2 From the menu, choose Rename.

The report instance is highlighted and you can edit its name.

Step 3 Enter a new name and press Enter.

The report instance is renamed and listed with the new name.
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Deleting a Report Instance
You can delete report instances.

Step 1 In the Templates view or Favorites view, right-click a report instance. 

You can also choose more than one instance. To choose several instances, hold down the Ctrl key while 
choosing the report instances, and then right-click.

A popup menu appears (Figure 4-14).

Figure 4-14 Popup Menu

Step 2 From the menu, choose Delete. The chosen report instances are deleted.

Removing a Report Instance from Favorites

Step 1 In the Favorites view, right-click a report instance. A popup menu appears, see Figure 4-15.

Figure 4-15 Favorites Popup Menu

Step 2 From the menu, choose Remove from Favorites.

The report instance is removed from the Favorites view.
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Modifying a Report Chart Title

Step 1 In the Favorites view, right-click a report instance. A popup menu appears, see Figure 4-16.

Figure 4-16 Favorites Popup Menu

Step 2 From the menu, choose Properties.

The report chart instance is highlighted and you can edit its title.

Step 3 Enter a new title and press Enter.

The report chart instance is renamed and listed with the new title.

Step 4 To add the SCE as subtitle, configure the report chart instance properties.

Set the value of Show SCE on Title to true.

Step 5 Click  (Execute).

The report is generated with the configured values.
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C H A P T E R 5 

Working with Reports

Revised: September 17, 2012, OL-26822-01

Introduction
After you have created and defined a report instance, you can generate reports from the report instance.

You can:

 • Display reports in chart or tabular form

 • Adjust the chart display

 • Export the chart display and the report data

 • Report Actions, page 5-2

 • Generating Reports, page 5-6

 • Viewing Reports, page 5-12

 • Adjusting the Chart Display, page 5-14

 • Exporting Reports, page 5-23
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Report Actions
The views found on the SCA Reporter display menu items. Some commonly used actions have icons for 
easy navigation.

The actions and their icons are described in Table 5-1.

Table 5-1 Reporter Actions and Icons 

Action Icon Description Comments

Home Opens the Welcome view. —

Menu Displays all of the available 
actions for the view.

Common to all views.

View Filter — Filters display of template groups 
in the Templates view.

Display either all template groups 
or only groups that can be used 
when the service configuration that 
generated the data is running in 
asymmetric routing classification 
mode.

Debug Displays template code. In the Templates view—Used to 
debug the structure of a report 
template.

Execute Generates the choose report. In the Properties view, Templates 
view, and Favorites view.

New or Report 
(from Legend)

Creates a new report instance. In the Templates view—When you 
choose a report template, the icon 
is new.

In each report view—When you 
right-click a legend item, the 
Subset of Template Groups and 
Templates dialog box appears. 
Choose a template and click OK. 
The report instance is created 
(modified).

Refresh Collapses open nodes in the 
Templates view so that only the 
template groups are displayed.

In the Templates view and 
Favorites view.

Show Cmd Opens a window displaying the 
CLI command for the report 
instance.

In the Properties view, Templates 
view, and Favorites view —The 
CLI commands are placed on the 
clipboard. You can paste them into 
a vanilla text editor, edit them, and 
then execute them from a command 
file shell or a command prompt.

Delete Deletes the report instance. In the Templates view and 
Favorites view.

Duplicate Creates a copy of the report 
instance.

In the Templates view.
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Rename Highlights the report instance so 
that you can rename it.

In the Templates view and 
Favorites view.

Show Categories Toggles between displaying 
properties with and without 
categories.

In the Properties view.

Show Advanced 
Properties

Toggles between displaying basic 
properties and displaying all 
properties.

In the Properties view.

Restore Default 
Value

Restores property default value. In the Properties view—Default 
values can be a value or (not set). 
Mandatory properties are not reset 
to (not set).

Go to report — Navigates from the choose report 
view to the associated report 
instance in the Templates view.

In each report view.

Export raw data — Opens a Browse dialog box. In each report view.

Show List Lists generated reports that for 
which no report view is open.

Above the report views—To 
display a report, click the icon and 
choose from the report names in the 
drop-down list.

The number in the icon indicates 
how many reports are not in view.

Preferences — Opens a dialog box that allows 
you to choose whether to show 
system tasks or not.

Sleeping (waiting) tasks are 
shown in either case.

In the Progress view—The icon 
is displayed while system tasks are 
running.

Remove All 
Finished Tasks

Removes all completed tasks. In the Progress view and Reports 
view.

Open Hierarchy 
View

Opens the Hierarchy view.  In the Templates view.

Add to Favorites Adds the report instance to the 
Favorites view.

In the Templates view.

Remove From 
Favorites

Removes the report instance from 
the Favorites view.

In the Favorites view.

Export to PDF Exports the report in view; 
including the table and chart, to 
PDF.

In the Reports view.

View Table with 
External Program

Exports the table in view to an 
external application associated 
with CSV file format.

In the Reports view.

Copy Chart Image 
to Clipboard

Copies the chart image in view to 
the clipboard.

In the Reports view.

Table 5-1 Reporter Actions and Icons (continued)

Action Icon Description Comments
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Send by E-mail Attaches the table or chart in view 
to an e-mail using your default 
e-mail application.

In the Reports view.

Print Prints the table or chart in view. In the Reports view.

Based on 
configured service 
tree

Configures the hierarchical tree 
according to the configured 
service tree.

In the Hierarchy view.

Based on service 
popularity

Configures the hierarchical tree 
according to service popularity.

In the Hierarchy view.

Reset Zoom Resets the zoom on the report 
view

In the Reports view.

Table 5-1 Reporter Actions and Icons (continued)

Action Icon Description Comments
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Filtering Report Templates and Instances
Report templates and instances can be filtered so that only specific templates and instances are displayed 
in the Templates view.

How to Filter Report Templates and Instances

Step 1 In the Templates view, enter a word, phrase, or more complex expression in the field.

The templates containing the text entered are displayed, see Figure 5-1.

Figure 5-1 Templates With Entered Text

How to Clear the Filter

Step 1 In the Templates view, click (Clear).

The filter is cleared and all templates and instances are displayed in the Templates view.
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Generating Reports 
You can generate a report from an existing, defined report instance. Report instances are found in the 
Templates view. You can duplicate, modify, rename, or delete the report instances and you can add report 
instances to the Favorites view (see Managing Report Instances, page 4-1). You can generate multiple 
reports; you can put the generate process in the background while working on other reports.

Some types of reports cannot be generated using data collected from an SCE platform running in 
asymmetric routing classification mode.

You can define and generate reports using the SCA Reporter Command-Line Interface (CLI). You can 
also use the CLI to preschedule reports. (See The SCA Reporter Command-Line Interface, page 6-1.)

 • How to View Report Types that can be Generated in Asymmetric Routing Classification Mode, 
page 5-6

 • How to Generate a Report When a Report Instance is Selected, page 5-7

 • How to Generate Multiple Reports, page 5-7

How to View Report Types that can be Generated in Asymmetric Routing 
Classification Mode 

Step 1 In the Templates view, from the drop-down menu, choose View Filter >Split-flow.

Template groups whose report instances cannot be executed for asymmetric routing classification mode 
data are hidden, see Figure 5-2.

Figure 5-2 Templates With Split Flow
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How to Generate a Report When a Report Instance is Selected 

Step 1 In the Templates view, select a report instance.

The Properties view displays the report instance properties.

Step 2 Click (Execute).

The report is generated and is displayed in a new report view.

The Properties view displays the chart display properties.

How to Generate Multiple Reports 

Note The maximum number of reports that can be generated simultaneously is configurable. If you select 
more report instances than the maximum value, the generation of some of the reports are queued.

Step 1 From the Templates view window, while you hold down the CTRL key, choose the required report 
instances.

The selected report instances are highlighted.

Step 2 Click (Execute).

An Executing report dialog box appears while reports are being generated, see Figure 5-3.

Figure 5-3 Progress Dialog

Step 3 Select a further action to take.

Do one of the following:

 • Wait until the system task status at the bottom right corner of the SCA Reporter indicates that report 
generation is complete.

While the reports are being generated, the system task status shows: 
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 How to Generate Multiple Reports
 • Click Details.

The status of all reports that are being generated is displayed, see Figure 5-4.

Figure 5-4 Report Status

 • Click Run in Background.

Report generation continues running in the background. After it finishes, each report is displayed in 
a separate report view.

 • Click Cancel.

You can cancel a running report generation. It can take the Database Server a short time to 
acknowledge a cancel request, but you can move the canceled report to the background and continue 
your work uninterrupted.
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Managing the Chart Items Hierarchy
After reports are generated, the Hierarchy view displays a hierarchy of all the chart items included in the 
report.

There are two modes in which the tree structure can display the hierarchy:

 • Service popularity—Configures the hierarchy according to significance. The chart item creating the 
most significant traffic is first in the hierarchy and the chart item with the least significant traffic is 
last in the hierarchy.

 • Configured services tree—Configures the hierarchy according to the defined policy tree.

Note The Hierarchy availability depends on the report type. For example, pie charts have no hierarchy.

How to Configure the Hierarchy Mode

Step 1 Generate a report.

Step 2 To view the hierarchical tree in configured services tree mode, click  (based on configured 
services tree).

The hierarchy is configured according to the service policy.

The chart is refreshed to reflect the hierarchy.

Step 3 To view the tree in service popularity mode, click  (based on service popularity).

The hierarchy is configured according to traffic weights.

The chart is refreshed to reflect the hierarchy.

Manipulating the Hierarchy
After a report is generated, you can manipulate the chart items in the Hierarchy view to view a subset of 
the data included in the report. When the hierarchy is manipulated, the report is automatically refreshed 
to reflect the changes. You can perform the following actions:
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 • Viewing only the parent chart items—You can contract the parent nodes so that the report displays 
only the parent chart items without identifying the specific children, see Figure 5-5.

Note When a parent node is contracted, the parent node value is an aggregation of all the values of its 
children nodes.

Figure 5-5 Report Displaying Only Parent Chart Items

 • Expanding the parent chart items—The parent nodes can be expanded to drill down and identify all 
the specific chart items included in the parent, see Figure 5-6.

Note In service tree-based mode, if a parent chart item has a child that is not assigned a global usage 
counter, when the parent is expanded, both the parent and the child chart items appear on the 
chart.

Figure 5-6 Report Displaying Expand Parent Chart Items
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 • Unchecking chart items—You can uncheck chart items in the hierarchy to remove them from the 
report, see Figure 5-7.

Figure 5-7 Removing Chart Items By Unchecking

 • Checking chart items—You can check chart items in the hierarchy to add them to the report.

Note When checking or unchecking a parent node, all the children mirror the parent. However, you 
can check or uncheck individual chart items to view in the report.
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Viewing Reports
You can view a report as a chart or as a table.

Step 1 To select the desired display, click the appropriate tab located at the bottom-left of the report view, see 
Figure 5-8.

Figure 5-8 Report Chart
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The table is useful for locating specific information, see Figure 5-9.

Figure 5-9 Report Table

You can configure table contents and display properties:

 • Copying contents of a cell—To copy the contents of a cell in the table, right-click on the cell and 
choose Copy.

 • Sorting items in the table—To sort the table data in ascending or descending order, click on a column 
heading by which you want to sort the data. 
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Adjusting the Chart Display
You can change the appearance and type of any report chart by modifying chart display properties, such 
as three-dimensional display settings, chart rendering, and chart colors. You can also change the 
appearance of a report.

 • Drag the legend to a different spot in the report.

 • Hide the legend.

 • Hide items from the legend; the corresponding items in the graph will be removed from view.

 • Zoom in or out—Drag the graph so that the desired section is in focus.

 • Configuring the Properties of a Chart Display, page 5-14

 • Changing the Appearance of the Chart, page 5-16

 • Zooming Items, page 5-18

 • Managing the Chart Legend, page 5-20

 • Managing the Chart Legend, page 5-20

Configuring the Properties of a Chart Display
You configure chart display properties in the Properties view. As you change the properties, the chart 
display is updated. There are also adjustments that are made directly in the report view (see Adjusting 
the Chart Display, page 5-14).

Note Changes to chart display properties are not saved in the report instance. When you next execute the report 
instance, the report is generated with default chart display properties.

Table 5-2 lists chart display properties and their descriptions:

Table 5-2 Chart Display Properties 

Property Type Default Values Comments

Look 

3D Boolean True True, False Toggles between 
the two values.

Chart rendering Single choice Depends on report 
template

See list following 
this table

The chart can be 
displayed in many 
graphical formats.

Legend visibility Boolean True True, False Toggles between 
the two values.

Look/3D 
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Table 5-3 shows possible values for the Chart Rendering property.

Table 5-4 lists the properties set in the 3D Properties dialog box and their possible values.

Oblique Boolean True True, False Only displayed 
when 3D is True.

If True, the angle 
between the x and 
y axis is always 
90 degrees when 
the chart is rotated.

Settings Sliding scale See table 
following this 
table

See table 
following this 
table

Only displayed 
when 3D is True.

Opens the 3D 
properties dialog 
box with sliding 
scales for eight 
graphical 
properties.

Table 5-2 Chart Display Properties (continued)

Property Type Default Values Comments

Table 5-3 Chart Display Types 

 • BAR

 • STACKED_BAR

 • STACKED100_BAR

 • SUPERIMPOSED_BAR

 • AREA

 • STACKED_AREA

 • STACKED100_AREA

 • POLYLINE

 • STACKED_POLYLINE

 • STACKED100_POLYLINE

 • SCATTER

 • STAIR

 • STACKED_STAIR

 • STACKED100_STAIR

 • SUMMED_STAIR

 • PIE

Table 5-4 3D Chart Properties 

Property Values Default

Rotation –90 ... 90 35

Elevation –90 ... 90 45

Depth 0 ... 100 20

Depth Gap 0 ... 100 0

Zoom 0 ... 200 100

Ambient Light 0 ... 100 10

Light Latitude –90 ... 90 0

Light Longitude –90 ... 90 0
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Changing the Appearance of the Chart 
You can change the chart type of the report, adjust the graphical display of the chart, and change the 
colors used in the chart.

 • Changing the Chart Type, page 5-16

 • Modifying a Graphical Display, page 5-16

 • Changing Chart Colors, page 5-17

Changing the Chart Type

Step 1 Generate a report. A Report view appears displaying the report, and the Properties view displays the 
chart display properties.

Step 2 In the Properties view, select the Chart Rendering row, and click the Browse button to open a drop-down 
list (Figure 5-10).

Figure 5-10 Properties Drop-Down Menu

Step 3 From the drop-down list, choose the type of chart that you want to display.

When you click another area in Properties view, the report updates.

Modifying a Graphical Display

Step 1 Generate a report. A report view appears displaying the report, and the Properties view window displays 
the chart display properties.

Step 2 To display the chart in two dimensions, click the 3D property.

The value of the 3D property toggles from True to False and the Look/3D category is removed from the 
Properties view window.

Step 3 Click the 3D property again.

The chart displays in three dimensions, and the Look/3D category reappears.
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Step 4 Select the Settings property. The 3D properties dialog box appears, see Figure 5-11.

Figure 5-11 3D Properties

Step 5 Change the 3-dimensional properties using the sliding scales.

Step 6 The chart display changes as you change the properties.

Step 7 Click OK. The new values are assigned to the Settings property.

Changing Chart Colors

You can change the default color applied to a legend item in a chart. You may want to change the chart 
colors if, for instance, legend items that are adjacent in the chart have similar colors.

Note If legacy coloring is enabled (see the “Setting Chart Colors” section on page 2-13), this option is not 
available.

Note You can create and apply your own color sets globally. See the “Setting Chart Colors” section on 
page 2-13.
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Step 1 Generate a report. A Report view appears, displaying the report.

Step 2 Right-click on an item in the legend. A popup menu appears, see Figure 5-12.

Figure 5-12 Report Legend Popup Menu

Step 3 From the menu, select either Edit Color (this chart only) or Edit Entity Color. The former option 
changes the color temporarily for this chart only, the latter makes the change persistent for all current 
and future charts. A color palette appears, see Figure 5-13.

Figure 5-13 Color Palette

Step 4 Choose a new color from the palette.

Step 5 Close the palette. The new color is applied in the chart to the selected variable.

If you chose Edit Entity Color at Step 3, the new color is applied to all open charts, except those using 
temporary colors.

Zooming Items
 • Zooming In on a 2-Dimensional Chart, page 5-19

 • Dragging a Zoomed-In Chart, page 5-19

 • Zooming Out of a Chart, page 5-19
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Zooming In on a 2-Dimensional Chart

You can zoom in or out of two-dimensional charts.

While you are zoomed-in, you can drag the chart to view different sections.

Step 1 Generate a Report. A report view appears displaying the report, and the Properties view displays the 
chart display properties.

Step 2 To display the chart in two dimensions, click the 3D property.

The value of the 3D property toggles from True to False and the Look/3D category is removed from the 
Properties view.

Step 3 Mark off a rectangle by dragging the mouse over the chart.

The cursor changes to a plus icon.

Step 4 Release the mouse button, and the view zooms in.

Dragging a Zoomed-In Chart

Step 1 Generate a Report and display the chart in two dimensions.

Step 2 Zoom in to the top part of the chart.

Step 3 To move the chart down, click it with the middle mouse button, while dragging the chart.

The chart moves up, and the bottom of the chart appears.

Zooming Out of a Chart

Step 1 Mark off a rectangle by right-clicking it while dragging the mouse over the chart.

The cursor changes to a minus icon.

Step 2 Release the mouse button, and the view zooms out.

Zoom Reset

Step 1 In the report view, click  (Reset Zoom).

The report view is reset to its original settings.
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Managing the Chart Legend
You can move the chart legend from its default position, or you can remove it from the chart display.

Note You can also globally configure how the legend is displayed. See the “Configuring the Legend in Charts” 
section on page 2-19.

 • Moving the Chart Legend, page 5-20

 • Hiding the Chart Legend, page 5-20

Moving the Chart Legend

Step 1 Generate a report.

A Report view appears displaying the report.

Step 2 Right-click the legend of the chart and drag it to the required position.

The legend moves to the new position.

Hiding the Chart Legend

Step 1 Generate a report.

The Properties view displays the chart display properties.

Step 2 To hide the chart legend, click the Legend visibility property.

The value of the Legend visibility property toggles from True to False and the chart legend is removed 
from the chart.
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Managing Report Output
You can manage report output in several ways:

 • Print, send by e-mail, or export reports to PDF format.

 • Save charts to a number of graphic formats.

 • Save tables to CSV or Quoted CSV formats, which you can open as spreadsheets.

 • Print, send, or export multiple reports in one send operation.

Printing Reports

Step 1 After executing one or more report instances, choose File > Print Reports.

The Print Reports wizard appears, see Figure 5-14.

Figure 5-14 Print Reports Wizard

Step 2 Choose one or more formats for each report you are printing.

Step 3 Click Finish.

The selected reports print in the format or formats you chose.

Note For PDF and CSV formats, the print feature uses the desktop interface and only prints if the 
associated application can print from the desktop. If you can print from the desktop without 
opening the application, the print feature will work.
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Note If you selected several reports to print, the application may freeze for several moments while 
sending the reports to the printer.

Sending Reports by E-mail

Step 1 After executing one or more report instances, select File > Send Reports.

The Send Reports wizard appears, see Figure 5-15.

Figure 5-15 Send Reports Wizard

Step 2 Choose one or more formats for each report you are sending.

Step 3 Click Finish.

An e-mail message appears from the default e-mail application installed on the desktop, with the selected 
reports attached.
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Exporting Reports

Step 1 After executing one or more report instances, select File >Export.

The Export wizard appears, see Figure 5-16.

Figure 5-16 Export Wizard

Step 2 Choose one of the following:

 • Export chart to an image file

 • Export report to a PDF file

 • Export table to a CSV file
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Step 3 Click Next.

The Tables and Destination page of the Export wizard appears, see Figure 5-17.

Figure 5-17 Charts and Destination

Step 4 Check one or more of the Available reports.

Step 5 (Optional) To change the Output folder, click Browse.
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Step 6 Do one of the following:

 • If you chose Report in Step 2, continue with Step 8.

 • If you chose Chart, or Table in Step 2, click Next.

The Format page of the Export wizard appears (Figure 5-18 or Figure 5-19). (The display depends 
on whether you chose Chart or Table in Step 2.)

Step 7 Enter required information.

Do one of the following:

 • (For Chart)

Figure 5-18 Chart Format

 – From the File type drop-down list, choose a file type.

 – In the Image width and Image height fields, enter values in pixels.
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 • (For Table)

Figure 5-19 Table Format

 – From the File type drop-down list, choose a file type.

Step 8 Click Finish.

Each report selected is saved in a separate file.
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The SCA Reporter Command-Line Interface

Revised: September 17, 2012, OL-26822-01

Introduction
This chapter describes the various ways of using the Cisco Service Control Application Reporter 
(SCA Reporter) Command-Line Interface (CLI) for executing the SCA Reporter features, including the 
syntax, switches, and options of the application.

 • Command-Line Interface Overview, page 6-1

 • Prescheduled Reports, page 6-2

 • Syntax and Usage, page 6-3

Command-Line Interface Overview 
The SCA Reporter Command-Line Interface (CLI) is a command-line application that complements the 
functionality of the SCA Reporter GUI. You can integrate the CLI, which provides capabilities and 
flexibility beyond that of its SCA Reporter GUI counterpart, into third-party applications to generate 
usage-based and statistics-based output.

The CLI includes the following features:

 • Runs under Windows or Linux

 • Runs predefined report instances or uses report templates

 • Allows prescheduling of periodic generation of reports
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Prescheduled Reports 
You can use the Reporter CLI to produce selected reports periodically. You must configure an external 
scheduling utility (for example, cron, PyCron, or Windows scheduler) to do produce selected reports 
periodically. You can use either an existing report instance or a report template, as explained in various 
sections in this chapter.

The following shows an example of a cron line to produce a “Global Bandwidth per Service” report every 
hour:

20 * * * * reportercmd -report "Global Bandwidth per Service #1" -params \ 
"numhours=24;units=Mbit/s;avgdata=true;trafficdir=Both Directions" \ -format jpeg -o 
GBpS1.jpeg
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Syntax and Usage 
You can execute the SCA Reporter as a command-line version that accepts input passed as parameters. 
In the Templates view, you can create a CLI command, either from a report instance or from a report 
template. The database information and the SCE platform IP parameters are included in the created CLI 
command, in addition to configured parameters.

When you create the command, it is automatically copied to the clipboard. You can now paste the 
command into a command file shell or a command prompt and then execute it after making any necessary 
changes. You must then add the file name in which to save the data and the format in which to save it. 
These parameters are not included when the command is created.

Not all parameters that exist in the original report instance are included in the params switch. When a 
parameter is not listed in the CLI invocation, and:

 • If the command is based on a report instance, the value is taken from the report instance.

 • If the command is based on a report template, the default value is used. (You must define the values 
of mandatory parameters that do not have default values.)

 • Command-Line Usage, page 6-3

 • Command-Line Switches, page 6-4

 • Command-Line Options, page 6-4

 • How to Generate Reporter Commands for a Report Instance, page 6-6

 • How to Generate Reporter Commands for a Report Template, page 6-8

Command-Line Usage 
You can invoke the SCA Reporter application for a report instance using a command such as:

reportercmd -report "Global Bandwidth per Service #1" -dbdriver "com.mysql.jdbc.Driver" 
-dburl "jdbc:mysql://10.56.201.89:3306/apricot" -dbuser "pqb_admin" -dbpassword 
"pqb_admin" -policysce "10.56.201.87" -params "titleText=Global Bandwidth per 
Service;services=Flash Yahoo,HTTP,Google Talk File Transfer,Other 
Flash;numhours=24000;trafficdir=Both Directions;link=Link 0,Link 
1;showSce=false;avgdata=true;units=Mbps" -o "myfile" -format "jpeg"

You can invoke the SCA Reporter application for a report template using a command such as:

reportercmd -template "Global Bandwidth per Service" -dbdriver 
"com.sybase.jdbc3.jdbc.SybDriver" -dburl "jdbc:sybase:Tds://10.56.99.13:4100" -dbuser 
"pqb_admin" -dbpassword "pqb_admin" -policysce "10.56.98.10" -params "endtime=2008-04-13 
10:46:20;titleText=Global Bandwidth per Service;services=Flash Yahoo,HTTP,Google Talk File 
Transfer,Other Flash;numhours=24000;starttime=2008-04-12 10:46:20;trafficdir=Both 
Directions;seip=10.56.201.87;link=Link 0,Link 1;showSce=false;avgdata=true;units=Mbps" 
-hierarchy services;1 -o "myfile" -format "jpeg"

You can generate a string to serve as the basis for a CLI command from the SCA Reporter. The generated 
command does not include the -o and -format parameters, which must be added to the command. You 
can also modify other parameters.
6-3
Cisco Service Control Application Reporter User Guide

OL-26822-01



 

Chapter 6 The SCA Reporter Command-Line Interface
 Command-Line Switches
Command-Line Switches 
The following switches can be included in the command line when invoking the SCA Reporter 
application:

 • -report 

 – -dbdriver 

 – -dburl 

 – -dbuser 

 – -dbpassword 

 – -policysce 

 – -params 

 – -o 

 – -format 

 – -show 

 • -template 

 – -dbdriver 

 – -dburl 

 – -dbuser 

 – -dbpassword 

 – -policysce 

 – -params 

 – -o 

 – -format 

 – -show 

 • -help 

 • -list 

Command-Line Options 
Table 6-1 describes the options of the command line for invoking the SCA Reporter application:

Table 6-1 Command-Line Options for SCA Reporter Application 

Option Action by SCA Reporter Comments

-report "report-name" Generates a report using the 
specified name of a report instance.

Use this parameter when 
generating a report from an 
existing report instance.

-template "template-name" Generates a report using the 
specified name of a report template.

Use this parameter when 
generating a report from a 
template.
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-dbdriver "db-driver" The driver for the database. The same database that is 
configured in the SCA Reporter.

-dburl "db-url" The URL of the database. —

-dbuser "db-user" The user of the database. —

-dbpassword "db-password" The password for the database. —

-policysce "IP of SCE for 
policy data" 

The IP address of the SCE platform 
whose service configuration data 
will be used in the report.

The IP address of the SCE 
platform that is configured in the 
SCA Reporter.

-params 
"param1=value1;..." 

Parameters from the Properties view. When a particular parameter is 
not listed, the default value is 
used.

-o "filename" The name of the file to which to 
direct output.

If the file name exists, the 
original file is overwritten.

-format "fileformat" Specifies whether to output the 
report as a chart or as a table. The 
fileformat parameter can take one 
of the following values:

 • jpeg 

 • csv 

 • pdf

—

-show Shows the structure (including 
parameters) of a report or template 
instead of executing it.

—

-help — —

Table 6-1 Command-Line Options for SCA Reporter Application (continued)

Option Action by SCA Reporter Comments
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How to Generate Reporter Commands for a Report Instance 

Step 1 Select a report instance from the Templates view.

Step 2 From the drop-down menu in the tab, select Show Cmd.

A Command line invocation dialog box appears, see Figure 6-1, displaying the generated command.

Figure 6-1 Command Line Invocation Dialog

Step 3 Click OK.

The command, with all the switches and parameters, is placed on the clipboard.

-list Outputs a list of all template groups 
and report templates.

—

-hierarchy "mode; level; 
group-for sorted"

Defines the report hierarchy 
attributes:

 • mode—The mode of the 
hierarchy tree. This attribute can 
accept one of the following 
values:

 – services—service 
popularity mode

 – sorted—configured services 
tree mode

 • level—The default level at 
which the tree is expanded.

 • group-for sorted—The number 
of items to include in each 
group.

Note This attribute is only 
relevant for sorted.

—

Table 6-1 Command-Line Options for SCA Reporter Application (continued)

Option Action by SCA Reporter Comments
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Step 4 Open a file or command prompt.

Do one of the following:

 • Open a file from which to execute the command from a shell and save the file in the Reporter 
directory.

 • Open a command prompt from which to execute the CLI command and change the directory to the 
Reporter directory.

Step 5 Paste the clipboard contents.

The command is pasted in the file or in the command line.

Step 6 Add the mandatory flags.

 • -o "filename"

 • -format "fileformat"

Step 7 (Optional) Change parameters. For example, you may want to change the numhours parameter, see 
Figure 6-2.

Figure 6-2 Change Parameters Example

Step 8 Execute the command.

The exported file is saved in the defined directory with a time stamp appended to the name of the report 
instance.
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How to Generate Reporter Commands for a Report Template 

Step 1 Select a report template from the Templates view.

Step 2 From the drop-down menu in the tab, select Show Cmd, see Figure 6-3.

A Command line invocation dialog box appears, displaying the generated command.

Figure 6-3 Command Line Invocation Dialog

Parameters that have default values are given the default value. A value of ___ (underscore) indicates 
mandatory parameters that do not have default values.

Step 3 Click OK.

The command, with all the switches and parameters, is placed on the clipboard.

Step 4 Open a file or command prompt.

Do one of the following:

 • Open a file from which to execute the command from a shell and save the file in the Reporter 
directory.

 • Open a command prompt from which to execute the CLI command and change the directory to the 
Reporter directory.

Step 5 Paste the clipboard contents.

The command is pasted in the file or in the command line.

Step 6 Add the mandatory flags.

 • -o "filename"

 • -format "fileformat"

Step 7 (Optional) Change parameters. For example, you may want to change the numhours parameter, see 
Figure 6-4.

Figure 6-4 Change Parameters Example
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Step 8 Execute the command.

The exported file is saved in the defined directory with a time stamp appended to the name of the report 
instance.
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Installing and Upgrading SCA Reporter 
Templates

Revised: September 17, 2012, OL-26822-01

Introduction
This appendix describes how to install and upgrade Cisco Service Control Application Reporter 
(SCA Reporter) report templates.

 • Installing Report Templates, page A-2

 • Upgrading Report Templates, page A-9
A-1
ice Control Application Reporter User Guide



 

Appendix A Installing and Upgrading SCA Reporter Templates
 Installing Report Templates
Installing Report Templates

Step 1 At the Main menu, choose Help > Find and Install. The Install/Update dialog box appears (Figure A-1).

Figure A-1 Install Feature Updates
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Step 2 Check the Search for new feature to install radio button and click Next, see Figure A-2.

Figure A-2 Update Sites to Visit

Step 3 Click New Local Site.

The Select Local Site Archive dialog box appears.

Step 4 Browse to the archive file and select it.

The file is named SCAS_bb_template_.<version>B<build>.zip. For example, the file may be named 
SCAS_bb_template_3.1.6B8.zip.

Step 5 Click Open.

The Edit Local Site dialog box appears displaying the file name and its location and contents, see 
Figure A-3.

Figure A-3 Edit Local Site Dialog
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Step 6 Click OK (Figure A-4).

Figure A-4 Update Sites to Visit - Update Sites Selected
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Step 7 Click Finish, see Figure A-5.

Figure A-5 Feature License Dialog
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Step 8 Accept the agreement and click Next.

The Updates dialog box appears with the installed features available for the site, see Figure A-6.

Step 9 Select the required feature, which should be named SCAS BB Templates<version.<build>. For 
example, the file may be named SCAS BB Template 3.1.6.8.

Figure A-6 Updates Dialog
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Step 10 (Optional) To install the feature in a different location, click Change Location, and browse to the 
required location (Figure A-7).

Figure A-7 Change Location
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Step 11 Click Finish (Figure A-8).

Figure A-8 Feature Verification

Step 12 Click Install or Install All (Figure A-9).

Figure A-9 Install/Update Dialog

Step 13 Click Yes, and wait for the application to appear.

The computer restarts. The new report templates are installed.
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Upgrading Report Templates

Step 1 At the Main menu, choose Help > Find and Install. The Install/Update dialog box appears 
(Figure A-10).

Figure A-10 Install Feature Updates

Step 2 Check the Search for updates of the currently installed features radio button.

Step 3 Click Finish.

One of the following occurs:

 • There are no updates (Figure A-11).

Figure A-11 No Updates Dialog
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 • There are updates.

The wizard appears (see Installing Report Templates, page A-2).
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Troubleshooting

Revised: September 17, 2012, OL-26822-01

Introduction
If you encounter a problem while using the Cisco Service Control Application Reporter (SCA Reporter), 
use the information in this appendix to help isolate its cause. The procedures in this appendix assume 
that you are troubleshooting the initial system startup, and that the GUI is in the original factory 
configuration. If you have changed any default settings, the recommendations in this appendix might not 
apply.

 • Using the Troubleshooting Appendix, page B-1

 • General Troubleshooting, page B-2

 • Troubleshooting Setup Errors, page B-2

 • Troubleshooting Using the Command Line Interface, page B-2

 • Troubleshooting Parameter Definition Errors, page B-3

 • Checking System Conditions, page B-4

 • Viewing the Error Log, page B-4

 • Viewing the Installed Version of Report Templates, page B-5

Using the Troubleshooting Appendix
This appendix describes the subsystems available for efficient problem solving. After applying the 
solutions in this appendix, if you are still unable to solve an issue, contact a customer service 
representative for assistance. Provide the representative with the following information:

 • Type of software and release number

 • Brief description of issue

 • Brief explanation of the steps taken to isolate and resolve the issue

 • Maintenance agreement or warranty information

While working in the SCA reporter, you can also access online help.
B-1
ice Control Application Reporter User Guide



 

Appendix B Troubleshooting
 General Troubleshooting
General Troubleshooting
Searching the Help menu allows you to learn more about the SCA Reporter while you are working. You 
can get assistance with the following functions from the Help menu:

 • Creating a Basic Configuration

 • Accessing Online Help

 • Checking System Conditions

 • Managing Configuration

 • Installing and Upgrading Templates

 • Viewing Plug-in Details

You can also access online help while working in the SCA Reporter (see Using Online Help, page 2-22).

Troubleshooting Setup Errors
If the GUI does not open, check the following:

 • Ensure that adequate memory is installed and available.

 • Uninstall an old release before installing a new release.

 • Ensure that the database is installed and populated.

 • Ensure that the IP address of the computer is not connected to another device.

Troubleshooting Using the Command Line Interface
For details on using and troubleshooting the SCA reporter command line interface (CLI), see the 
following sections in either Cisco SCE8000 CLI Command Reference or Cisco SCE 2000 or SCE 1000 
CLI Command Reference:

 • CLI Help Features

 • Navigational and Shortcut Features

 • Managing Command Output
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Troubleshooting Parameter Definition Errors
In this example, a mandatory property is not set (Figure B-1).

Figure B-1 Mandatory Property Not Set

When the report instance is executed, an error message appears (Figure B-2).

Figure B-2 Error Message

To view specifics on an error, click Details (Figure B-3).

Figure B-3 Error Message Details
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Checking System Conditions
You can check the system conditions to ascertain if:

 • Database connection is defined correctly and that the connection is active

 • System is correctly configured

Step 1 From the Main menu, choose Help > Check Conditions. A Condition testing message appears 
(Figure B-4).

Figure B-4 Condition Testing Message

Step 2 Click OK.

Viewing the Error Log
To configure debug message logging, see the “Configuring the SCA Reporter” section on page 2-7. 
When this mode is activated, you can view the error log.

Step 1 From the Main menu, choose Help > About SCA Reporter.

The About SCA Reporter dialog box appears.

Step 2 Click Configuration Details.

Step 3 Click View Error Log.
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Viewing the Installed Version of Report Templates
When there is a change in a database structure, but the repository is not updated, Template Repository 
errors may exist. For details, see the “Installing and Upgrading SCA Reporter Templates” section on 
page A-1.

Note Before the installation, you may need to update the files used for installation and upgrade.

Step 1 From the Main menu, choose Help > About SCA Reporter. The About SCA Reporter dialog box 
appears.

Step 2 Click Plug-in Details. The About SCA Reporter Plug-ins dialog box appears.

Step 3 Verify that the version of SCA BB Templates is correct.

Step 4 Click OK. The About SCA Reporter Plug-ins dialog box closes.

Step 5 Click OK. The About SCA Reporter dialog box closes.
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Revised: September 17, 2012, OL-26822-01

Introduction
This appendix describes the Cisco Service Control Application Reporter (SCA Reporter) as a tool in the 
SCA BB Console. For more information about the SCA BB Console, see Cisco Service Control 
Application for Broadband User Guide.
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How to Use the SCA Reporter Tool in the SCA BB Console 
The SCA Reporter can be run as a tool in the SCA BB Console.

Step 1 Choose Start > All Programs > Cisco SCA > SCA BB Console 3.8.0 > SCA BB Console 3.8.0. The 
SCA BB Console appears (Figure C-1).

Figure C-1 SCA BB Console

Step 2 Configure and activate a database connection. (See Managing Database Connections, page 2-7.)
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Step 3 From the Console main menu, choose Tools > Reporter.

The Reporter tool opens (Figure C-2).

Figure C-2 Reporter Tool
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Step 4 You use the Reporter tool in the same way that you use the SCA Reporter as a standalone, as described 
in this manual (Figure C-3).

Figure C-3 Reporter Tool With Report Displayed
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SCA Reporter Templates

Revised: September 17, 2012, OL-26822-01

Introduction
This appendix describes the Cisco Service Control Application Reporter (SCA Reporter) report 
templates.

 • Information About Report Templates, page D-2

 • Global Monitoring Template Group, page D-8

 • Package Monitoring Template Group, page D-9

 • Virtual Links Monitoring Template Group, page D-10

 • Subscriber Monitoring Template Group, page D-11

 • Traffic Discovery—Statistics Template Group, page D-12

 • Demographic Data and Service Popularity Reports Template Group, page D-13

 • Web and Streaming Reports Template Group, page D-14

 • Mail and News Reports Template Group, page D-15

 • P2P Reports Template Group, page D-16

 • VoIP Reports Template Group, page D-17

 • Malicious Traffic Template Group, page D-19

 • IPv6 Reports Template Group, page D-19

 • Mapping Between RDRs and Reports, page D-20
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Information About Report Templates
The SCA Reporter installation includes report templates that you use to generate report instances. The 
templates are grouped by common themes. Each report template allows you to create new report 
instances. Default filter values are assigned to the properties, some of which are common to all the 
instances in a given group. You can impose additional constraints by configuring the properties.

Note The default filters are the values that are initially applied to the properties. Before generating a report, 
you can reconfigure its properties. In order to reset properties to their default values, select properties 
and click  (Restore Default Value. Some mandatory properties have the default value  (not 
set); these properties must be assigned a value before a report can be generated. Optional properties may 
be assigned a value of  (not set). To view all properties, click  (Show Advanced Properties.

You generate a report instance by selecting a report template from the list of available groups in the 
Templates view.

There are two main categories of reports:

 • Monitoring reports—Show how network resources are used for selected services at various 
granularities (global, package, subscriber)

 • Traffic Discovery reports—Provide statistical information about network activity and help identify 
the characteristics of the traffic traversing the network

 • Report Instance Properties, page D-2

 • Information About Monitoring Reports, page D-5

 • Information About Traffic Discovery Reports, page D-6

Report Instance Properties
Table D-1 lists properties that appear in report templates that belong to more than one template group. 
(Properties of report instances that belong to only one template group are listed with the description of 
the group.)

Table D-1 Common Properties of Report Instances 

Property Field Type Default Comments

Items to Focus on 

One of the following is included in most report templates:

 • Services to view Multiple Choice (not set) When not set, all 
services are selected.

 • Select services to 
view

Multiple Choice (not set) When not set, all 
services are selected.

 • Focus on the 
service

Single Choice (not set) When not set, all 
services are selected.

One of the following two properties is included in many report templates:

 • Packages to View Multiple Choice (not set) When not set, all 
packages are selected.
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 • Package Single Choice  (not set) Mandatory property.

Name of subscriber to 
focus on

Free Text (not set) Mandatory property for 
Subscriber template 
group report instances.

IP address (decimal 
format) or subscriber 
name.

Time Frames to focus Multiple Choice (not set) When not set, all four 
time frames are 
selected.

Time Boundaries—See note following table.

Starting after date Time/Date (not set)

Ending before date Time/Date (not set) When not set, the report 
is bound to the current 
time.

 • From the last 
number of hours

Free Text 24 Ignored when the 
Starting After Date and 
Ending Before Date 
properties are both set.

 • From the last 
number of Days

Free Text 7

Specific Time Date/Time  (not set) Mandatory property.

Appears in three report 
instance types instead of 
the other three time 
boundary properties.

The selected time is 
rounded to the nearest 
hour/day.

Traffic Parameters 

Link to Focus Multiple Choice (not set) List of available links to 
focus.

One of the following is included in many report templates:

Traffic Direction Single Choice Depends on report 
template

Depends on report 
template:

 • Direction only

 • Direction and 
metric

Metric to order Single Choice Depends on report 
template

Depends on report 
template and metric:

 • Metric only

 • Metric and 
direction

Table D-1 Common Properties of Report Instances (continued)

Property Field Type Default Comments
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 • All report instances include the SCE IP to view property, which enables filtering to a specific SCE 
platform. This property is mandatory and persistent. Persistent means that the current value is used 
for all subsequent reports until the value is changed.

 • Time Boundaries properties occur in all report instances except for Top Subscribers, Top Talkers, 
and Relative Consumption of Top Subscribers. These properties are:

 – Starting After Date

 – Ending Before Date

 – From the Last Number of Hours/Days

 • The property From the last number of hours/days is set to a default value in all report instances. 
When all three Time Boundaries properties are set, the From the last number of hours/days 
property is ignored. When the property Ending before date is not set, the report is bound to the 
current time.

Data Show 

Pick BW Over Single Choice 1 Hour

SCE IP to view Multiple Choice At installation:  (not 
set)

Thereafter: most recent 
assigned value

IP address of specific 
Service Control Engine 
(SCE) platforms.

Units of results Single Choice Depends on report 
template

Limit number of results Free Text 10

Average Data by Hour Boolean True If this option is selected, 
a single, average value 
is calculated for each 
hour of the report. This 
option is recommended 
when generating the 
report for 24 hours or 
more.

Show other 
Consumption

Boolean False

Aggregation Period Single Choice Hourly

Subscriber Id Free Text (not set) Pattern that represents 
group of subscribers.

Table D-1 Common Properties of Report Instances (continued)

Property Field Type Default Comments
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Information About Monitoring Reports
Report-monitoring provides information about the distribution and consumption of network resources. 
This information helps you understand how the network is used at different granularities (such as for the 
entire link, for traffic generated by all subscribers in a specific package usage counter, or for traffic 
generated by a specific subscriber). These reports are critical for tuning the Service Control Solution 
configuration according to changing network patterns.

Monitoring reports are created from Link Usage, Package Usage, and Real-Time Subscriber Usage Raw 
Data Records (RDRs). These SCE platform generated RDRs provide periodic usage information (at 
various granularities) that is processed according to the selected report template to provide the final 
report.

Monitoring reports typically show a specific metric for a set of service usage counters at a selected 
granularity, such as bandwidth for P2P and Browsing service usage counters at a link granularity, or 
volume for the Streaming service usage counter for subscribers in the Gold package usage counter.

You select the service usage counters on which to report via the SCA Reporter. The available service 
usage counters are those counters defined in the service configuration of the SCE platform from which 
the reports are generated.

 • Granularity, page D-5

 • Using Metrics, page D-6

Granularity

The granularityof a report instance controls which traffic the generated report addresses. Three 
granularities are supported:

 • Global—Provides visibility into all traffic processed by the SCE platforms being reported on. Use 
global granularity to view the global distribution of network resources (for example, total P2P 
bandwidth for the last 24 hours).

 • Package—Reports on traffic mapped to subscribers in a specific package usage counter. Use 
package granularity to monitor how subscribers assigned to a specific package usage counter (for 
example, the total volume of streaming traffic for all subscribers assigned to the Gold package usage 
counter in the last 10 days) use network resources. See the “Using the Service Configuration Editor: 
Traffic Control” chapter of Cisco Service Control Application for Broadband User Guide for a 
description of how to define different packages in the system.

To generate package usage counter reports, subscribers must be defined (in any of the subscriber 
modes) and assigned to a specific package. See “Using the Subscriber Manager GUI Tool” chapter 
of Cisco Service Control Application for Broadband User Guide for a description of how to manage 
subscribers.

 • Subscriber—Provides insight into the activity of a single subscriber defined in the Service Control 
solution. Use subscriber granularity to view how a specific subscriber is using network resources 
(for example, the number of P2P sessions generated by a specific subscriber for each hour during 
the last 12 hours). Subscriber reports are available for those subscribers flagged for real-time 
reporting. For a description of managing real-time subscriber reporting, see “Using the Service 
Configuration Editor: Traffic Accounting and Reporting” chapter of Cisco Service Control 
Application for Broadband User Guide.
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 Information About Traffic Discovery Reports
Each report template generates reports in a specific granularity. Each type of report is accessible from 
the corresponding report template group:

 • Global report templates are accessible from the Global Monitoring Template Group, page D-8.

 • Package report templates are accessible from the Package Monitoring Template Group, page D-9.

 • Subscriber report templates are accessible from the Subscriber Monitoring Template Group, 
page D-11.

Using Metrics

A metric is the statistic being reported on. The following metrics are available:

 • Bandwidth—The total bandwidth consumed by the selected services. By default, a bandwidth report 
is displayed as a stacked-area chart, where each area indicates the bandwidth used by a specific 
service.

When generating a bandwidth report, you can select the direction: upstream, downstream, or both.

You can also display an hourly average of bandwidth. This metrics is recommended when you are 
generating a report for many hours. In this case, a single data point per hour is sufficient: it reduces 
the quantity of data displayed, improving performance and the visualization of the data.

 • Volume—The total volume (in kilobytes or megabytes) for a specific period, for the selected service 
usage counters. As opposed to the bandwidth metric, which provides normalized volume over time, 
volume reports give the total volume consumed, grouped by specific time durations. By default, a 
volume report is displayed as a stacked-bar chart, where each bar/series indicates the volume of a 
specific service usage counter.

Volume reports give the accumulated usage either for specific durations of time (hours or days), or 
for the entire duration of the report. For example: a Global Hourly Usage Volume report displays a 
bar that accounts for the total volume consumed by each service usage counter during each hour of 
the selected time frame, and a Global Aggregated Usage Volume per Service report accounts for all 
volume of each service usage counter for the entire time frame of the report.

 • Sessions—The number of sessions. A session is a single network transaction (for example, RTSP 
stream or P2P file download). By default, a sessions report is displayed as a stacked-bar chart, where 
each bar/series indicates the total number of sessions of a specific service usage counter.

Similar to the volume reports, sessions reports can be grouped into specific durations (hours or days), to 
account for the total number of sessions in a specific hour/day consumed by a specific service usage 
counter.

Note Volume and bandwidth are reported in layer 3.

Information About Traffic Discovery Reports
Traffic discovery reports provide raw statistics for analyzing network activities. They are useful for 
obtaining information on the general activity in the IP network, and they are the key for defining the 
service configuration of the system.

Traffic discovery reports are based on the information in Transaction RDRs.
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 Information About Traffic Discovery Reports
Traffic Discovery reports generate histograms and distribution charts that are grouped by a selected 
criterion and sorted by the selected order parameter. For example, a Top Protocols report is sorted by 
Total Volume, and a Top Web-hosts report is sorted by Hit-Count.

 • Criteria for Reporting, page D-7

 • Order Property, page D-7

Criteria for Reporting

Each report template focuses on a specific criterion based on Layers 3 - 7, such as:

 • Top Servers IP addresses

 • Top Server Port numbers

 • Top HTTP web-hosts

 • Top NNTP news-groups

Order Property 

The Metric to order property indicates the value by which the report is sorted. Possible values are:

 • Upstream Volume

 • Downstream Volume

 • Both Directions Volume—Total upstream and downstream volume

 • Hit-Count—Number of transactions

You can limit each report to a specific number of results. This limiting allows you to focus on the top 
areas of activity (according to the selected value).
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Global Monitoring Template Group
The Global Monitoring group of report templates allows you to view statistics about the traffic 
bandwidth or volume that was consumed. The bandwidth/volume consumption can be displayed per 
service for the entire link.

The Global Monitoring group includes the following report templates:

 • Global Bandwidth per Service—Shows the distribution of bandwidth among the different services 
defined in the system for all traffic, regardless of subscriber or package.

 • Global Aggregated Usage Volume per Service—Shows the total volume of traffic (upstream and 
downstream) for each service usage counter (for all traffic, regardless of subscriber or package).

 • Global Hourly Usage Volume per Service—Shows the distribution of volume among the different 
service usage counters defined in the system, grouped by hour.

 • Global Hourly Aggregated Minutes per Service—Shows the total number of minutes used for each 
service usage counter defined in the system, grouped by hour.

 • Global Hourly Usage Sessions per Service—Shows the distribution of sessions among the different 
service usage counters defined in the system, grouped by hour.

 • Global Concurrent Session per Service—Shows the distribution of concurrent sessions among the 
different service usage counters defined in the system.

 • Global Daily Usage Sessions per Service—Shows the distribution of sessions among the different 
service usage counters defined in the system, grouped by day.

 • Global Daily Usage Volume per Service—Shows the distribution of volume among the different 
service usage counters defined in the system, grouped by day.

 • Daily Peak BW for All Packages—Shows the daily value of the maximum bandwidth (one hour or 
two hour average), for all packages.

 • Average Subscriber Bandwidth per Service—Shows the average bandwidth consumed per 
subscriber, for each service usage counter.

 • Average Subscriber Bandwidth—Shows the average total bandwidth consumed per subscriber.

 • Global Bandwidth per Service and Total Bandwidth—Shows the bandwidth used by each service 
usage counter, compared to the total link bandwidth.

 • Global Bandwidth per Traffic Direction—Shows the upstream and downstream bandwidth over 
time.

 • Global Bandwidth per Service comparison—Shows the bandwidth used by groups of service usage 
counters combined by a subscriber.
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Package Monitoring Template Group
The Package Monitoring group of report templates allows you to view statistics of bandwidth or volume 
of traffic used by a package. The reports are provided per service usage counter for the total volume used 
by the package. The volume consumption can be displayed per service for the package.

The Package Monitoring group includes the following report templates:

 • Package Bandwidth per Service—Shows the distribution of bandwidth among the different service 
usage counters defined in the system for all subscribers belonging to a specific package.

 • Package Aggregated Usage Volume per Service—Shows the total volume of traffic (upstream and 
downstream) for each service usage counter (for subscribers in a specific package).

 • Multi Package Bandwidth per Service—Shows the distribution of bandwidth among the different 
service usage counters defined in the system for all subscribers belonging to specific packages.

 • Package Hourly Usage Volume per Service—Shows the distribution of volume among the different 
service usage counters defined in the system, for the traffic of subscribers in a specific package 
usage counter, grouped by hour.

 • Package Hourly Aggregated Minutes per Service—Shows the total number of minutes used for each 
service usage counter for a specific package usage counter defined in the system, grouped by hour.

 • Package Hourly Usage Sessions per Service—Shows the distribution of sessions among the different 
service usage counters defined in the system, for the traffic of subscribers in a specific package, 
grouped by hour.

 • Package Concurrent Session per Service—Shows the distribution of concurrent sessions among the 
different service usage counters for a specific package usage counter defined in the system.

 • Package Daily Usage Sessions per Service—Shows the distribution of sessions among the different 
service usage counters defined in the system, for the traffic of subscribers in a specific package 
usage counter, grouped by day.

 • Package Daily Usage Volume per Service—Shows the distribution of volume among the different 
service usage counters defined in the system, for the traffic of subscribers in a specific package 
usage counter, grouped by day.

 • Daily Peak BW for Each Package—Shows the daily value of the maximum bandwidth (one hour or 
two hour average), for the traffic of subscribers in specific package usage counters.
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Virtual Links Monitoring Template Group
The Virtual Links Monitoring group of report templates allows you to view statistics of bandwidth or 
volume of traffic used by a virtual link. The reports are provided per service usage counter for the total 
volume used by the virtual link. The volume consumption can be displayed per service for the virtual 
link.

These reports cannot be generated using data collected from an SCE platform running in asymmetric 
routing classification mode.

For more information on monitoring virtual links, see Cisco Service Control for Managing Remote Cable 
MSO Links Solution Guide.

Table D-2 lists properties used only by the Virtual Links Monitoring group of report templates.

The Virtual Links Monitoring group includes the following report templates:

 • VLink Bandwidth per Service—Shows the distribution of bandwidth among the different service 
usage counters defined in the system for all subscribers.

 • VLink Aggregated Usage Volume per Service—Shows the total volume of traffic (upstream and 
downstream) for each service usage counter.

 • VLink Bandwidth per Package—Shows the distribution of bandwidth among the different packages 
defined in the system for selected vlinks.

 • VLink Hourly Usage Volume per Service—Shows the distribution of volume among the different 
service usage counters defined in the system, grouped by hour.

 • VLink Daily Usage Volume per Service—Shows the distribution of volume among the different 
service usage counters defined in the system, grouped by day.

 • Daily Peak BW for all VLinks—Shows the daily value of the maximum bandwidth (one or two hour 
average) for all virtual links.

 • Top VLink by Usage Volume—Shows the top vlinks by usage volume.

 • Total Active Subscribers per VLink—Shows the number of active subscribers for a selected vlink. 

 • Vlink Bandwidth per Cable-Modems Group—Shows the distribution of bandwidth for the selected 
Cable-Modems group.

Note To generate the Vlink Bandwidth per Package report, enable the CM RAG Adapter and configure 
the vlink bandwidth per package aggregation.

Table D-2 Properties of Virtual Links Monitoring Group Templates Only 

Property Field Type Default Comments

Items to Focus on 

Select VLink ID Free Text (not set) —

Select VLink direction Single Choice (not set) —

Select VLink names Multiple Choice (not set) —
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Subscriber Monitoring Template Group
The Subscriber Monitoring group of report templates allows you to view statistics about the bandwidth 
or volume of traffic used by the subscriber. The reports are provided per service usage counter for the 
total volume consumed by the subscriber. A Top Subscribers report identifies the subscribers that 
consume the largest traffic volume. Subscriber bandwidth and volume reports can be generated for those 
subscribers configured for real-time monitoring. See “Selecting Subscribers for Real-Time Usage 
Monitoring” in “Additional Management Tools and Interfaces” chapter of Cisco Service Control 
Application for Broadband User Guide for a description of how to configure real-time subscribers.

The Subscriber Monitoring group includes the following report templates:

 • Top Subscribers—Shows a list of the top subscriber volume consumption in a specific hour/day.

 • Subscriber Bandwidth per Service—Shows the distribution of bandwidth among the different 
service usage counters defined in the system for a specific subscriber.

 • Subscriber Aggregated Usage Volume per Service—Shows the most popular service usage counter 
for a specific subscriber.

 • Subscriber Hourly Usage Volume per Service—Shows the hourly distribution of volume among the 
different service usage counters defined in the system for a specific subscriber

 • Subscriber Hourly Aggregated Minutes per Service—Shows the total number of minutes used for 
each service usage counter for a specific package usage counter defined in the system, grouped by 
hour.

 • Subscriber Hourly Usage Sessions per Service—Shows the hourly distribution of sessions among 
the different service usage counters defined in the system for a specific subscriber.

 • Subscriber Daily Usage Sessions per Service—Shows the daily distribution of sessions among the 
different service usage counters defined in the system for a specific subscriber.

 • Subscriber Daily Usage Volume per Service—Shows the daily distribution of volume among the 
different service usage counters defined in the system for a specific subscriber.

 • Daily Peak BW for Specific Subscriber—Shows the daily value of the maximum bandwidth (one or 
two hour average), for a specific subscriber.

 • Peak Bandwidth per Subscriber—Shows the peak bandwidth for a specific subscriber, all 
subscribers, or subscribers by pattern, in a specified time frame.
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Traffic Discovery—Statistics Template Group
The Traffic Discovery—Statistics group of report templates allows you to view statistics compiled from 
the source and destination IP addresses and ports of the system traffic.

The reports cannot be generated using data collected from an SCE platform running in asymmetric 
routing classification mode.

Note The reports in this group are not per subscriber; they supply general port and IP address information.

Note The reports in this group can often show inaccurate or inconsistent data because they are based on 
statistical information. Instead of using the Top Protocols report, use the Global Monitoring/Global BW 
per Service report.

Table D-3 lists the property used only by the Traffic Discovery - Statistics group of report templates.

The Traffic Discovery - Statistics group includes the following report templates:

 • Top Servers—Shows the most popular servers for certain services.

Note Server refers to the IP address of the other side of the flow initiator. It may be located on the 
Subscriber side or on the Network side.

 • Top Client—Shows the most popular client IP for certain services.

Note Client refers to the IP address of the flow initiator. It may be located on the Subscriber side or 
on the Network side.

 • Top Server Ports—Shows the most popular server ports for certain services.

 • Top Service Ports—Shows the most popular server ports of a certain service or services.

 • Top Protocols—Shows the most popular protocol for certain services.

 • Top IP Protocols—Shows the most popular IP protocol for certain services.

 • Top Server IP to Server Port—Shows the most popular server IP to server port for certain services.

 • Top Client IP to Server Port—Shows the most popular client IP to server port for certain services.

 • Top Client IP to Server IP—Shows the most popular client IP to server IP for certain services.

 • Top Client IP to Server IP and Server Port—Shows the most popular server IP and server port for 
certain services.

Table D-3 Property of Traffic Discovery - Statistics Group Templates Only 

Property Field Type Default Comments

Traffic Parameters 

Transport Protocol Single choice TCP —
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Demographic Data and Service Popularity Reports Template 
Group

The Demographic Data and Service Popularity group of report templates allows you to view statistics of 
the demographic data.

The Demographic Data and Service Popularity group includes the following report templates:

 • Global Active Subscriber per Service—Shows the distribution of subscribers among the different 
services defined in the system for all traffic, regardless of subscriber or package.

 • Package Active Subscriber per Service—Shows the distribution of bandwidth among the different 
services defined in the system for specific subscriber package.

 • Total Active Subscribers—Shows the average number of active subscribers per period in days.

 • Service Popularity among Subscribers—Shows the percentage of subscribers using a specific 
service defined in the system.

 • Service Popularity among Subscribers of a Specific Package—Shows the percentage of subscribers 
using a specific service in a specific package defined in the system.

 • Relative Consumption of Top Subscribers—Shows the relative consumption of a specific number of 
subscribers compared to “other”.

 • Top Subscribers Usage Distribution per Service—Shows the distribution of services by a selected 
metric for a specific top subscriber, or all top subscribers.

 • Service Popularity among Subscribers (Average)—Shows the total number of subscribers using a 
specific service compared to subscribers using all other services.

 • Service Popularity among Subscribers of a Specific Package (Average)—Shows the total number of 
subscribers using a specific service compared to subscribers using all other services in a specific 
package.

 • Cumulative Distribution of Subscriber Usage—Shows the cumulative distribution of traffic volume 
by subscribers.

 • Subscribers Average Consumption—Shows the distribution of the average subscriber consumption.
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Web and Streaming Reports Template Group
The Web and Streaming group of report templates allows you to compile statistics presenting the most 
popular servers or hosts for the various predefined system services (such as Browsing, Streaming, and 
Downloading) and for user-defined services.

These reports cannot be generated using data collected from an SCE platform running in asymmetric 
routing classification mode.

Note The reports in this group can often show inaccurate or inconsistent data because they are based on 
statistical information.

Table D-4 lists the property used only by the Web and Streaming group of report templates.

The Web and Streaming group includes the following report templates:

 • Top Web Hosts—Shows the most popular web servers, grouped by page impressions.

 • Top Rtsp Hosts—Shows the most popular real-time streaming protocol (RTSP) servers.

 • Top FTP Servers—Shows the most popular FTP file hosts.

 • Top MMS Servers—Shows the most popular MMS hosts.

 • Top Service Servers—Shows the most popular servers of a certain service or services.

 • Service Distribution by Subscriber Packages—Shows the most popular web servers, grouped by the 
package of the requesting subscriber.

 • Rtsp Host Distribution by Subscriber Packages—Shows the most popular RTSP servers, grouped by 
the package of the requesting subscriber.

 • FTP Server Distribution by Subscriber Packages—Shows the most popular FTP file servers, 
grouped by the package of the requesting subscriber.

 • MMS Server Distribution by Subscriber Packages—Shows the most popular Microsoft Manager 
Server servers, grouped by the package of the requesting subscriber.

 • Service Distribution by Subscriber Packages—Shows the distribution of service usage according to 
the subscriber packages.

Table D-4 Property of Web and Streaming Group Templates Only 

Property Field Type Default Comments

Items to Focus on 

Where host is contained Free Text (not set) Filter to hosts 
containing the given 
pattern.
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Mail and News Reports Template Group
The Mail and News group of report templates allows you to view statistics of the mail and news traffic.

These reports cannot be generated using data collected from an SCE platform running in asymmetric 
routing classification mode.

Note The reports in this group can often show inaccurate or inconsistent data because they are based on 
statistical information. The following reports have a deterministic alternative: 
 
- Top E-mail Recipients—Use the Subscriber Monitoring/Top Subscribers report, and filter it to focus 
on the POP3 service. 
- Top E-mail Senders—Use the Subscriber Monitoring/Top Subscribers report, and filter it to focus on 
the SMTP service. 
- Top NNTP Consumers—Use the Subscriber Monitoring/Top Subscribers report, filter it to focus on the 
NNTP service.

The Mail and News group includes the following report templates:

 • Top SMTP Servers—Shows the most popular SMTP hosts.

 • Top POP3 Servers—Shows the most popular POP3 hosts.

 • Top NNTP Servers—Shows the most popular NNTP hosts.

 • Top E-mail Sender—Shows the top e-mail sender.

 • Top E-mail Recipients—Shows the top e-mail recipients.

 • Top NNTP Consumers—Shows the top NNTP consumers.

 • Top Newsgroups—Shows the most popular newsgroups.

 • SMTP Server Distribution by Subscriber Packages—Shows the most popular SMTP servers, 
grouped by the package of the requesting subscriber.

 • POP3 Server Distribution by Subscriber Packages—Shows the most popular POP3 servers, grouped 
by the package of the requesting subscriber.

 • NNTP Server Distribution by Subscriber Packages—Shows the most popular NNTP servers, 
grouped by the package of the requesting subscriber.

 • Top Subscriber to Newsgroup—Shows the top subscriber to newsgroup for certain services.

 • Top E-mail Account Owners—Shows the top e-mail account owners.
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P2P Reports Template Group
The P2P group of report templates allows you to view statistics of the P2P traffic.

These reports cannot be generated using data collected from an SCE platform running in asymmetric 
routing classification mode.

The P2P group includes the following report templates:

 • Top P2P Protocols—Shows the most popular P2P protocol for certain services.

Note The P2P protocols can often show inaccurate or inconsistent data because they are based on 
statistical information. For a deterministic alternative use the Global Monitoring/Global BW per 
Service report and filter it to focus on the P2P service.

 • Top P2P Consumers—Shows a list of the top P2P subscriber volume consumption.

 • Top P2P Downloaders—Shows the top P2P download consumers.

 • Top P2P Uploaders—Shows the most popular P2P upload consumers.
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VoIP Reports Template Group
The VoIP group of report templates allows you to view statistics of the VoIP traffic.

These reports cannot be generated using data collected from an SCE platform running in asymmetric 
routing classification mode.

Table D-5 lists the properties used only by the VoIP group of report templates.

The VoIP group includes the following report templates:

 • Global Bandwidth per VoIP Service—Shows the distribution of bandwidth among the different VoIP 
services defined in the system for all traffic, regardless of subscriber or package.

 • Global Concurrent Calls per VoIP Service—Shows the distribution of concurrent sessions among 
the different VoIP service usage counters defined in the system, grouped by day.

 • Global Hourly Call Minutes per VoIP Service—Shows the distribution of call minutes among the 
different VoIP service usage counters defined in the system, grouped by day.

 • Global Call Minutes per VoIP Service—Shows the distribution of concurrent VoIP calls between the 
different services defined in the system.

 • Package Bandwidth per VoIP Service—Shows the distribution of bandwidth among the different 
VoIP services defined in the system for the traffic of subscribers in a specific package.

 • Packet Concurrent Calls per VoIP Service—Shows the distribution of concurrent sessions among the 
different VoIP service usage counters defined in the system, grouped by day.

 • Package Hourly Call Minutes per VoIP Service—Shows the distribution of call minutes among the 
different VoIP service usage counters defined in the system, grouped by day.

 • Subscriber Bandwidth per VoIP Service—Shows the distribution of bandwidth among the different 
VoIP services defined in the system for the traffic of subscribers in a specific package.

 • Subscriber Hourly Call Minutes per VoIP Service—Shows the distribution of call minutes among 
the different VoIP service usage counters defined in the system, grouped by day.

 • Top SIP Domains—Shows the most popular SIP Domains.

 • Top Talkers—Shows a list of the top talker volume/session/minutes consumption in a specific 
hour/day for a specific/all VoIP services.

 • Global VoIP Packets Loss—Shows the global number of lost packets in VoIP calls.

 • Global VoIP Jitter—Shows the global jitter measured in VoIP calls.

 • Global Hourly Average VoIP Packets Loss—Shows the average number of lost packets per VoIP call.

 • Global Hourly Average VoIP Jitter —Shows the average jitter measurement per VoIP call.

 • Global VoIP MOS—Shows the global VoIP quality estimation (Mean-Opinion-Score).

 • Global Hourly Average VoIP MOS—Shows the average VoIP quality estimation 
(Mean-Opinion-Score) per VoIP call.

Table D-5 Property of VoIP Group Templates Only 

Property Field Type Default Comments

Data Show 

Code to filter Multiple Choice (not set) —
D-17
Cisco Service Control Application Reporter User Guide

OL-26822-01



 

Appendix D SCA Reporter Templates
 VoIP Reports Template Group
 • Global VoIP MOS Distribution—Shows the distribution of VoIP quality estimation 
(Mean-Opinion-Score) values.

 • Global VoIP Codec Distribution—Shows the distribution of codecs that are used to encode VoIP 
calls on the network.

 • Average MOS per SIP Domain—Shows the average VoIP quality estimation (Mean-Opinion-Score) 
per SIP domain.

 • Calls Duration per SIP Domain—Shows the duration of calls in minutes per SIP domain.

 • Number of Calls per SIP Domain—Shows number of calls per SIP domain.

 • Top SIP User Agents—Shows the top SIP user agents ordered by hit count.

 • Top SIP Domains by Unique Users—Shows the top SIP domains ordered by the number of unique 
users.
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Malicious Traffic Template Group
The Malicious Traffic group of report templates allows you to view statistics of the malicious events 
accrued in the system.

Table D-6 lists properties used only by the Malicious Traffic group of report templates.

The Malicious Traffic group includes the following report templates:

 • Global Scan or Attack Rate—Shows the rate (session/sec) of scan/attacks originating from the hosts 
(typically because of a worm or zombie).

 • Global DoS Rate—Shows the rate (sessions/sec) of DoS attacks on the targeted host.

 • Top Scanning or Attacking Hosts—Shows the top hosts identified as DoS attacking.

 • Top DoS Attacked Hosts—Shows the top DoS-attacked hosts.

 • Infected Subscribers—Shows the distribution of infected subscribers over time among the different 
IP protocols in the system.

 • Infected subscribers vs Active Subscribers—Shows the distribution of infected subscribers over 
time, compared to all active subscribers.

 • DoS Attacked Subscribers—Shows the distribution of DoS-attacked subscribers over time among 
the different IP protocols defined in the system.

 • Top DoS Attacked Subscribers—Shows the top DoS-attacked subscribers.

 • Top Scanning or Attacking subscribers—Shows the top subscribers identified as DoS attacking.

 • Top Scanned or Attacked Ports—Shows the top scanned or attacked ports.

IPv6 Reports Template Group
The IPv6 group of report templates allows you to view the statistics of the IPv6 traffic.

The IPv6 group includes the following report templates:

 • IPv6 vs IPv4 Bandwidth Comparison—Shows the total bandwidth carried by each IP type.

 • Tunneled IPv6 Average Subscriber Bandwidth—Shows the average tunneled IPv6 bandwidth 
consumed per subscriber.

 • Tunneled IPv6 Concurrent Sessions—Shows the distribution of concurrent open tunneled IPv6 
sessions.

 • Tunneled IPv6 Active Subscribers—Shows the number of active subscribers using the tunneled IPv6 
bandwidth.

Table D-6 Properties of Malicious Traffic Group Templates Only 

Property Field Type Default Comments

Traffic Parameters 

IP protocol Single Choice (not set) —

Filter to port Free Text (not set) —

Detected IP side Single Choice (not set) —
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This section provides the mapping information between RDRs and reports. The mapping between 
the following categories:

 • Category 1 reports are for Usage RDRs—CM (CSV or DB)

 • Category 2 reports are for Real-Time Signaling RDRs—Attack Detection And Per-Transactio

 • Category 3 reports are for DHCP and RADIUS Sniffer Integrations used for SM

 • Category 4 reports are for QM

Note TAGs without descriptions are for internal use only.

Table D-7 lists the RDRs to Reports mapping.

Table D-7 RDRs to Reports Mapping 

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports

0xb2d05e01 4 — — — — — —

0xb2d05e02 4 — — — — — —

0xb2d05e04 1 — — — — — —

0xb2d05e05 1 — — — — — —

0xf0f0f000 1 4042321920 SUBSCRIBER_ 
USAGE_ RDR

ON Every 10  
minutes

RPT_NUR

RPT_ 
TOPS_ 
PERIOD0

RPT_ 
TOPS_ 
PERIOD1

Subscriber M

 • Top Subs

Demographic
Popularity

 • Relative C
Subscribe

VoIP

 • Top Talke
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onitoring

r Bandwidth per 

r Aggregated 
lume per Service

r Hourly Usage 
er Service

r Hourly 
ed Minutes per 

r Hourly Usage 
er Service

r Daily Usage 
er Service

r Daily Usage 
er Service

k BW for Specific 
r

r Bandwidth per 
ice

r Hourly Call 
er Service

NO

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f002 1 4042321922 REALTIME_ 
SUBSCRIBER_ 
USAGE_RDR

ON Every 1  
minute

RPT_SUR Subscriber M

 • Subscribe
Service

 • Subscribe
Usage Vo

 • Subscribe
Volume p

 • Subscribe
Aggregat
Service

 • Subscribe
Session p

 • Subscribe
Session p

 • Subscribe
Volume p

 • Daily pea
Subscribe

VoIP

 • Subscribe
VoIP Serv

 • Subscribe
Minutes p
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 Data & Service 

ctive Subscriber 
ce

opularity among 
rs of Specific 

opularity among 
rs of Specific 
Average)

andwidth per VoIP 

oncurrent Calls 
Service

ourly Call 
er Service

NO

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f004 1 4042321924 PACKAGE_ 
USAGE_RDR

ON Every 5  
minutes

RPT_PUR Package Mon

 • All Repo

Demographic
Popularity

 • Package A
per Servi

 • Service P
Subscribe
Package

 • Service P
Subscribe
Package (

VoIP

 • Package B
Service

 • Package C
per VoIP 

 • Package H
Minutes p
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opularity among 
rs

andwidth per VoIP 

oncurrent Calls per 
ice

ourly Call Minutes 
ce

NO

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f005 1 4042321925 LINK_USAGE_ 
RDR

ON Every 5  
minutes

RPT_LUR Global Monit

 • All Repo

Demographic
Popularity

 • Global A
Service

 • Service P
Subscribe

VoIP

 • Global B
Service

 • Global C
VoIP Serv

 • Global H
per Servi
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ndwidth per 
dems group

ncurrent Sessions 
ce

ily Usage Sessions 
ce

ily Usage Volume 
ce

urly Aggregated 
er Service

urly Usage 
per Service

urly Usage Volume 
ce

—

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f006 1 4042321926 VIRTUAL_ 
LINKS_USAGE_ 
RDR

OFF — RPT_VLUR Virtual Links 

 • Daily pea

 • Top VLin
Volume

 • Total Act
VLink

 • VLink Ag
Volume p

 • VLink Ba
Service

 • Vlink Ba
Cable-Mo

 • VLink Co
per Servi

 • VLink Da
per Servi

 • VLink Da
per Servi

 • VLink Ho
Minutes p

 • VLink Ho
Sessions 

 • VLink Ho
per Servi
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rts

ing

rts

rts 

rts

omains

YES

—

—

—

—

—

—

—

—

—

—

—

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f010 1 4042321936 TRANSACTION_ 
RDR

ON 100/sec  
Max

RPT_TR Traffic Discov

 • All Repo

Web & Stream

 • All Repo

Mail & News

 • All Repo

P2P 

 • All Repo

VoIP 

 • Top SIP D

0xf0f0f016 2 4042321942 FLOW_START_ 
RDR

OFF — CSV —

0xf0f0f017 2 4042321943 FLOW_ 
ONGOING_RDR

OFF — CSV —

0xf0f0f018 2 4042321944 FLOW_END_RDR OFF — CSV —

0xf0f0f019 2 4042321945 ATTACK_START_ 
RDR

OFF — CSV —

0xf0f0f01a 2 4042321946 ATTACK_END_ 
RDR

OFF — CSV —

0xf0f0f072 4 4042322034 QUOTA_ 
BREACH_RDR

OFF — QM —

0xf0f0f071 4 4042322033 QUOTA_STATUS_ 
RDR

OFF — QM —

0xf0f0f073 4 4042322035 QUOTA_ 
THRESHOLD_ 
BREACH_RDR

OFF — QM —

0xf0f0f070 4 4042322032 QUOTA_ 
SESSION_ 
CREATION_RDR

OFF — QM —

0xf0f0f040 1 4042321984 SERVICE_ 
BLOCK_RDR

ON — CSV —

0xf0f0f042 3 4042321986 DHCP_RDR OFF — LEG —
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ffic

rts

NO

—

—

—

—

IP Packets Loss

IP Jitter

ourly Average VoIP 
oss

ourly Average VoIP 

IP MOS

ourly Average VoIP 

IP MOS 
on

IP Codec 
on

NO

—

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f043 3 4042321987 RADIUS_RDR OFF LEG

0xf0f0f050 1 4042322000 MALICIOUS_ 
TRAFFIC_ 
P ERIODIC_RDR

ON Every 60  
seconds

RPT_ 
MALUR

Malicious Tra

 • All Repo

0xf0f0f438 1 4042323000 TRANSACTION_ 
USAGE _RDR

OFF — CSV —

0xf0f0f43c 1 4042323004 HTTP_ 
TRANSACTION_ 
USAGE_RDR

OFF — CSV —

0xf0f0f440 1 4042323008 RTSP_ 
TRANSACTION_ 
USAGE_RDR

OFF — CSV —

0xf0f0f46a 1 4042323050 VoIP_ 
TRANSACTION_ 
USAGE_RDR

OFF — CSV —

0xf0f0f46c 1 4042323052 MEDIA_FLOW_ 
RDR

ON — RPT_ 
MEDIA

VoIP

 • Global Vo

 • Global Vo

 • Global H
Packets L

 • Global H
Jitter

 • Global Vo

 • Global H
MOS

 • Global Vo
Distributi

 • Global Vo
Distributi

0xf0f0f480 1 4042323072 VIDEO_ 
TRANSACTION_ 
USAGE_ 
RDR

OFF — CSV —
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rs

 IPv6 Average 
r Bandwidth

 IPv6 Concurrent 

—

—

—

—

—

—

—

—

—

—

—

—

—

—

—

—

Table D-7 RDRs to Reports Mapping (continued)

TAG Category TAG (DEC) RDR Name ON/OFF Default Rate Table/CSV Reports Statistical
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0xf0f0f090 1 4042322064 GENERIC_ 
PERIODIC_RDR

ON Every 5 minutes RPT_GUR IPv6

 • IPv6 vs I
Comparis

 • Tunneled
Subscribe

 • Tunneled
Subscribe

 • Tunneled
Sessions

0x2108 1 — — — — — —

0x12fcb 1 — — — — — —

0x12fcf 1 — — — — — —

0x12fd0 1 — — — — — —

0xf4240 1 — — — — — —

0xa98671 1 — — — — — —

0xa98672 1 — — — — — —

0xa98673 1 — — — — — —

0xa98674 1 — — — — — —

0xa98a59 1 — — — — — —

0xa9ad81 1 — — — — — —

0xa9fba1 1 — — — — — —

0xaa22b1 1 — — — — — —

0xaa49c1 1 — — — — — —

0xaa70d1 1 — — — — — —
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